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Chapter 1 - Getting Started 

Introduction 

 
M2S Preview is a system for viewing patient-specific data on a personal computer. Raw 

scan data is extracted from computed tomography (CT) scans, MRI, or other sources, and 

rendered by Preview into a three-dimensional (3D) format. 

 

M2S Preview has many powerful viewing and measuring tools that are easy to use. Once 

you are familiar with the Preview tools, you will be able to determine methods for using 

the scan and 3D model data that best suit a specific procedure, a specific type of patient 

application, or an individual patient case. 



Preview User's Manual 

6 DES-MAN-1-02 Rev. P 

Overview 

 
This chapter will guide you through all of the aspects of M2S Preview. These sections 

will include:  

 

 Starting the Preview Program 

Instructions on how to start the Preview program and select patient data. 

  

 The Main Preview Window 

What you find when Preview starts up. 

  

 Verification of the Preview Model 

Using Model Pictures to verify proper model rendering by your computer system. 

  

 Reviewing Patient Information and Original Scan Specifications 

Reviewing the type of patient exam and original scan specifications (scan type, 

resolution, and slice spacing). 

  

 Working with the 3D Model 

Viewing the model from different angles and in various formats, and adding 

model views to your plan file. 

  

 Working with Slices 

Tools and commands available for viewing the scan images, adjusting image 

quality, and “jumping slices.” 

  

 “Dropping” a Slice into the 3D Model 

How to place a two-dimensional scan image in the 3D model. 

  

 Marking Slices 

How to create marks on a scan image and modify the format of the marks. 

  

 Bookmarking Slices 

How to create a reference to particular scan slices by “bookmarking” them. 

  

 Saving Your Work 
The steps you take to save a plan document. 

  

 Calculating Distances and Angles 

Using multiple marks to make calculations. 

  

 Calculating Volumes 

Using slices and marks to calculate the volume of an object or a set of objects. 

  



Chapter 1 - Getting Started 

7 DES-MAN-1-02 Rev. P 

 Calculating Centerlines or Path Length 

Using slices and marks to calculate the centerline of a bloodflow channel. 

  

 Printing a Preview Window 

How to print Preview’s images. 

  

 Creating a Report 
Collecting marks, calculations, notes, model pictures, and bookmarked slices in 

an HTML file you can print. 

  

 Ending the Preview Session 

How to exit the Preview program. 
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System Requirements 

 

Hardware Requirements  
This version of Preview operates on a personal computer (PC) with at least 256 MB* of 
RAM. In the table below, the minimum and recommended hardware components for 
operating Preview are specified. 
 

Hardware 

Component 

Minimum Recommended  Recommended 

Processor 800 MHz 2.4 GHz or faster 

RAM 256 MB* 512 MB or more 

Color Display 16-bit** per pixel 

(thousands of colors) 

32-bit per pixel color  

(millions of colors) 

Monitor 15-inch display 

 (1024 x 768 pixels) 

17-inch display  

(1280 x 1024 pixels or 

larger) 

CD-ROM Drive 48x 48x 

Hard Drive 400 MB of free hard-disk 

space 

400 MB of free hard-disk 

space 

Video Card Open GL compatible, non-

integrated 

ATI Radeon 9000 or better 

 
If your system falls below the minimum recommendations, we advise you not to install 
Preview or consult your IT technician.  
 
* Preview performance is improved if you do not run other major applications simultaneously. 
 
** Preview requires the color settings for your display to be set to either 16-bit or 32-bit colors. 16-bit color 
provides adequate color, but it does not allow the slice images to be shown with the full 8 bits of grayscale. 32-
bit color should always be used when possible. See Chapter 2 for more information about setting image quality 
using the Window/Level feature.  
 

 

Software Requirements 
M2S Preview requires that your PC must use one of the following Operating Systems: 

 Windows 8 (32 or 64 bit) 

 Windows 7 (32 or 64 bit) 

 Windows XP * 
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*Preview has been tested on Windows XP for accuracy, functionality and performance, 

but M2S does not support the XP platform. 

  

For functionality with the M2S' PEMS, you must have a compatible web browser, such 

as:  

 Microsoft Internet Explorer  

 Mozilla FireFox 

 Google Chrome 
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Installing Preview Software and Studies 

 

You can receive Preview studies and software from M2S in one of two ways:  
 

 A downloadable file received through the M2S PEMS website 
 
Note:  In order to view your downloaded study, you must have Preview 2.4 or later 
on your system.  If you do not, a Preview software download is available on the 
PEMS website (refer to instructions entitled “Installing Preview Software to your 
System….” which follows this section) 
  

 A Compact Disc (CD) which features a distribution of Preview as well as the model.  
 
Note: With the CD option, you can choose to install Preview onto your computer 
or you can choose to run the patient-specific program directly from the CD.  

Installing Preview Studies to your System using a 
Downloadable File from the PEMS Website 

 

1. Log onto PEMS 
 

Point your Web Browser to https://pems.m2s.com and log in using the credentials 

given to you by M2S. 

  

2. From the PEMS Home Page, select the patient study you wish to download 

by clicking on the flashing red arrow. 
 

Flashing red arrows indicate a study is available for download for up to seven 

days.  

 

A solid black arrow indicates the study has already been downloaded. 

  

3. You will notice that you have two choices:  download a Preview Model or 

download a Preview Plan.  Downloading the Preview model, whether blinded 

or unblinded, will provide you with the Preview model dataset, similar to 

what would be on the Preview CDs from M2S.  The Preview Plan provides 

only the M2S measurements for import into an open Preview model. 

  

4. Select the Preview model you wish to download.  When the dialog box 

appears, click on “Save” or “Save As”. 

   

   



Chapter 1 - Getting Started 

11 DES-MAN-1-02 Rev. P 

 
Click "Save" or "Save As" to save your file  

  

5. Name the file, confirm where you would like it saved, and click OK. 
 

We recommend you use a DSL, cable or T1 Internet connection to download files 

from PEMS.  Downloads are not recommended for dial-up service.  You may find 

that studies download quicker in non-peak hours (early am or late pm) because of 

less traffic on your network. 

 

How long will it take to download your study? 
 

That depends on the type of Internet connection you have, the bandwidth you 

have available, the volume of traffic on your network at the time of download, 

and your hardware and software configuration.  While waiting, you may minimize 

the download progress window and allow it to download in the background.  Be 

aware that any other Internet-based activities you do while downloading will 

affect the available bandwidth, therefore slowing down the downloading process. 

  

6. Once the download is complete, you will find that they are saved as single 

Preview Archive or .PAR files.  

  

7. To open the Preview study, simply double click on the .PAR file (first 

confirm you have Preview software loaded on your system). 

  

Note:  Sagittal and coronal views are not included with your Preview download.  They 

have been omitted from the PAR files in order to reduce the time it takes to download. 

 However, Preview has the ability to generate these views on request.  

  

 In Preview, select Help, Edit Preferences, Other, and select “Auto Create Sagittal 

and Coronal Slices”.   
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 Please note the regeneration of slices is a CPU-intensive process and may take 

several minutes. 
 

Installing Preview Software to your System Using a 
Downloadable File from the PEMS Website 

 

1. Log onto PEMS 
 

Point your Web Browser to https://pems.m2s.com and log in using the credentials 

given to you by M2S. 

  

2. From the PEMS Home Page, click on “Downloads” in the navigation menu. 
  

3. Under the Preview Software heading, click on  “Download the Full Preview 

Installation” 

  

4. When a dialog box appears, click on “Save” or “Save As”. 

  

5. Save the file to your desktop, hard drive, network, or onto removable media 

such as a CD or flash disk. 

  

6. Run the Installation Procedure 
 

Once the download is completed, run the installer file and follow the instructions 

on-screen to install the latest version of Preview. 

  

7. Read the Preview Release Notes 
 

After Preview installs, the Preview Release Notes dialog box appears.  Read these 

notes for helpful hints on how to best use this version of Preview. 

  

8. Load a Preview Study 
 

In order to load a Preview study, you may either download a Preview study 

through PEMS or place a patient-specific CD-ROM in your system and run 

Preview. 

Installing Preview to your Hard Drive using the CD-
ROM  

 
1. Insert the Preview CD-ROM into the CD-ROM drive. 

 

The Installation Option dialog box prompts you to choose running Preview from 
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your hard drive or off the CD. 
 
The Preview program is encoded onto each patient-specific CD-ROM. CD-ROM 
technology allows you to run the application directly from the CD-ROM drive with 
adequate performance without having to install it on your computer’s hard drive. 
Once you insert the CD-ROM into your CD-ROM drive, you launch the program 
and access the patient data from the CD-ROM. 

  

2. Click Yes to install Preview on your hard drive. 
 

By default, the Preview program copies itself to your computer’s hard drive in the 

folder C:\Program Files\M2S, and places a Shortcut to the Preview icon on your 

desktop and in the Start Menu. 

 

Note: On some operating systems you will need to have Administrator privileges 

in order to install. If this is the case, the installer will alert you and you may run 

Preview off the CD. To install Preview to your hard drive, contact your system 

administrator. 

 

Note: If you do not install Preview on your hard drive, you will be unable to use 

the latest version of Preview when viewing older data sets that you may have on 

CD’s. M2S highly recommends installing the most recent version whenever 

possible. 

  

3. Read the Preview Release Notes. 
 

After Preview installs, the Preview Release Notes dialog box appears. Read these 

notes for helpful hints on how to best use this version of Preview. 

Installation Problems?  

Check the Release Notes file that comes with your Preview software. 
 
If you experience problems while installing the Preview system, or if you have questions 
regarding your installation options, please see Chapter 6, M2S Preview Customer Support.  

 

Upgrading to the Latest Version of Preview  
 

M2S periodically upgrades its Preview software and you will receive the most current 

version of the software, as it becomes available, on your new patient CD-ROMs or at any 

time through the PEMS web site. If you are running Preview from your hard drive, you 

must install the new software versions onto your computer’s hard drive.  

Upgrading from the CD 
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To Upgrade from a CD with the latest version of Preview, follow the instructions below:  

 

1. Create a backup copy of the folder that contains measurement data. 

2. Insert the Preview CD-ROM into your CD-ROM drive.  
 

The program detects an earlier version of Preview on your computer’s hard drive 

and displays the Preview Version Option dialog box. The dialog box prompts you 

to select from the available versions of Preview. 

  

3. Select the newest version of the Preview software. 

 

The new version loads onto your computer’s hard drive. 

  

Upgrading through the PEMS Website 
  

To upgrade from the PEMS website, select the latest version of Preview under the 

Downloads tab and continue with the instructions listed above.   

 

Utilizing the Correct Display Settings  
 

For Preview’s colors and text to appear accurately, set Microsoft Windows’ Appearance 

settings to the default, set color to 32-bit, and select small fonts. To adjust your 

computer’s settings, perform the following steps: 

 

1. From the Windows Start menu, select Settings, then Control Panel. If using 

Windows XP, select Control Panel from the Start menu. 

  

2. Double-click the Display icon. Windows XP users may need to switch to 

classic view first. 

  

3. In the Display Properties window, click the Appearance tab. 

  

4. In the Scheme drop-down menu, select Windows Standard and click Apply. In 

Windows XP, the Color Scheme drop-down menu should be at Default (blue) 

and the font size should be Normal. 

  

5. Click the Settings tab. 

  

6. In the Colors drop-down menu, select Highest (32-bit) and click Apply. 
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7. Click the Advanced... button, and in the Font Size drop-down menu, select 

Small Fonts. Windows XP users do not need to perform this step. 

  

8. Click Apply, then Close. 

  

9. Restart your computer. 
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Organizing Patient Plans and Reports 

 

Preview creates a default folder for plan files. This folder is called Preview Plans and is 
found in your User name directory under …\<user name directory>\M2S\Preview Plans. 

Accessing the folder of Plan Documents and Reports 

In Preview, you will save marks, calculations, special model views, and drop slices in a 

plan and/or report document file.  To access the folder in which your plan documents are 

stored, perform the following steps: 

 

1. In Windows XP or Windows 7 
 

During the default installation, Preview will create a shortcut to the M2S directory 

on your desktop. Open this folder to view your M2S files. 

 

 
 

  

You now have a folder for your plan files. You can read about how to save your work in 

a plan document in Chapter 2, Using Preview. 
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Preview Indications for Use Statement 

 

Device Name: Preview® Treatment Planning Software 

 

US FDA 510(k)’s:  

Preview Surgery Planning Software  K953616  Cleared by FDA: 27 February 1996  

Preview® Treatment Planning Software K040852 Cleared by FDA: 23 April 2004 

 

 

Indications for Use: 

 

The Preview® Treatment Planning Software is intended to provide accurate, alternative 

two-dimensional images, as well as three-dimensional models, of patient specific 

anatomy from existing two-dimensional scan data of organs and tissues.  The Preview® 

product offers the physician the capability to view existing scan data in a format that is 

more user friendly, and thus enhances the physician’s capability to plan treatment.  The 

Preview® product is not intended to provide medical diagnosis or a recommended 

treatment approach. 
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Starting the Preview Program 

 
   

You can start Preview from one of two ways, depending on how you chose to install it.  

 

You can either:  

   

 

1. Run the program from the hard drive through the use of a desktop shortcut.  

  

2. Run the program from the hard drive through the use of Preview .PAR files.  

 

Running Preview through the Desktop Shortcut/Start Menu 

 
Running Preview from the hard drive requires an installation of Preview to be present on 

your hard drive as directed by the Installation wizard from a CD-ROM or PEMS.  

 

To run it from the hard drive, follow the steps below:  

 

1. On your desktop, select the Preview icon and follow the instructions from 

Step #3 on "Running Preview from the CD-ROM. " 

 

 
  

2. Alternatively, you can run Preview through the start menu:  

  

1. Click "Start" 

  

2. Go to "All Programs" (XP or Windows 7) 

  

3. Go to "M2S" 

  

4. Click on the "Preview" listing  

  

5. Preview should load, and the confirmation window appears:  

 



Chapter 2 - Using Preview  

19 DES-MAN-1-02 Rev. P 

 

 

  

6. Read the model notes and click "I have read the Important Model 

Notes above" (If you would like to Blind the patient data, check that 

box as well).  

  

7. To start Preview, press "Continue" and Preview's main interface will 

load.  
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Using the M2S Preview Palette 

 
When you open the M2S Preview application, you see the Preview Tool Palette on the 

right end of the menu bar 

 

:  

 

To select a tool from the palette, move the mouse pointer over the tool and click once. 

The Preview Tool Palette changes the function of the mouse, as you point and click in the 

Model and Slice areas. 

Note that when you move the mouse pointer over a tool, a box 

appears that names the tool and its shortcut keys. 

 

 

Mark/Rotate Tool  

 

 
 

The Mark/Rotate (arrow) tool is the standard selector tool you use to place, select, and 

move marks in Slice areas. In the Model area, you use the Mark/Rotate tool to rotate the 

3D model. The Mark/Rotate tool is selected by default when you launch the Preview 

program. 

 

Zoom Tool 

 

 
 

In a Slice area, clicking with the Zoom tool zooms in (enlarges) the selected slice image. 

To zoom out (reduce) a slice image, press and hold the Shift key and click on the image 

with the Zoom tool.  

 

 

To zoom in and out on the model, click the Zoom tool, put the cursor in the Model area, 

then hold the left mouse button down and drag up to zoom in and down to zoom out. 

 

Pan Tool 
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Use the Pan tool to pan (drag) an enlarged slice or model image in any direction within 

its area. 

 

Jump Slice Tool  

 

 
 

Use the Jump Slice tool on slices or the model to jump all slices and the model to the 

same location. 

 

Free Rotation Tool 

 

 
 

Use the Free Rotation tool to rotate the model. 

 

Polygon Tool 

 

 
Use the Selection Polygon Tool draw a polygon to measure and area and Perimeter 

 

Projection Toggle Tool 

 

 
 

Use the Perspective tool to change the model view to a perspective or orthographic 

projection. 

 

Making a Menu Selection 
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To choose a Preview menu command, follow these steps:  

 

1. Move the mouse pointer to the title of a menu in the Preview menu bar. 

   

   

 
 

  

2. Move the mouse pointer down to a selection in the menu and click the 

selection. 
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Loading PAR Files 

 
Preview studies can be exported, transported, and imported in "PAR" files. "PAR" files 
contain patient data that can only be opened through Preview; there are two ways that this 
can be done:  
 
 

1. After downloading a PAR file from the PEMS website, simply double click the PAR 
file and selected study will be automatically loaded into Preview. 
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Accessing Onscreen Help 

 
To access M2S Preview’s onscreen help, click the Help menu. Preview’s onscreen Help 
topics provide basic instructions for using Preview’s features, as well as descriptions of the 
menu commands and Tool Palette. 
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The Main Preview Window 

 
Once you verify that the correct patient data is loaded, Preview automatically opens and 

displays the Main Preview Window: the Aortic slices (with the first Aortic slice) at the 

bottom left of the screen, the 3D Model at the right with the Model View bar below it, the 

menu bar at the top of the screen, and a tabbed area beneath the menu bar that displays 

Patient information. 

   

The Main Preview Window looks something like this (click on the areas for more 

information): 

 

 
 

The Model Area 
 

 

M2S creates a 3D model from raw scan data acquired from a patient's CT, MRI, 

or other type of scan. The model is located in the "Model Area", a rectangular 

region that occupies the right side of the main Preview window. The model area 

automatically updates based on what you do in other areas. For example, when 

you place a mark in the slice window, the mark will also show up on the model 

window.   

 

In M2S Preview, you can view the model from any angle, with the default view 

being the Anterior view. For more information on this, see the section entitled 

Working with a 3D Model 
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Resizing the Model Area 

 

Depending on the shape of the scanned anatomy, you may want to resize the 

Model area. To resize the area, you can place the mouse pointer on the left border 

of the Model area and drag the area to the desired size. 

The Slice Area 
 

When Preview opens, the Slice area at the bottom-left of the Main Preview Window 

displays aortic right iliac slices. These slices represent the original scanned images 

received by M2S for processing. They are available for viewing at either 1- or 2-mm 

intervals, depending on the size of the anatomy scanned. Typically, Aortic Slice #0 is the 

topmost slice in the top-to-bottom scan series. Preview provides several methods for 

viewing all the slices in the scan. See Working with Slices later in this chapter for 

information on viewing slices. 

 

The first slice that will appear in the slice window is either the first aortic slice or the last 

viewed slice.  

  

Note: Slice numbers in Preview do not match the image numbers that may have been 

printed on CT films. Use anatomical references to determine the relationship of Preview 

images to films. 

 

Resizing the Slice Area  
 

As with the model window, the slice area can be resized at the convenience of the 

user through one of the following options:  

 

 Click the up-pointing arrow above the words “Aorta Slice: 0.” (To return 

the Slice area to its original size, click the down arrow.) 

  

 Place the mouse pointer on the top or right border of the Slice area and 

drag the area to the desired size. 

 

The Lists Area 
 

The row of tabs in the top-left corner of the Main Preview Window provides access to 

information that is part of your Patient Specific Software and the patient treatment plan 

you will create. As you add to your treatment plan, Preview collects your plan’s 

information, which can be accessed from the different tabs. 

 

When Preview opens, the Patient tab is selected, and the area beneath the tabs — the 

Lists area — displays the contents of the Patient tab: links to windows containing the 
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software ID, the patient’s specific scan data, the anatomy objects, the patient’s exam date 

and exam ID, model notes, model pictures and links to the PEMS website. 

   

 
 

To display another tab’s information in the Lists area, simply click the tab. Click the 

Views tab, for example, to display a list of Preview’s preset views of the model. After 

you have performed calculations, click the Calculations tab to see a list of your plan’s 

calculations. 
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Verification of the Preview Model 

 
Before you begin working with the model and slice images provided by the Patient-Specific 
Software, use Model Pictures to verify that your computer has rendered the data without 
error. 
 

1. Click the Patient tab (if not already selected) 
  

2. Click on the underlined, blue, "Model Pics" link.  
 

The "model pics" window will open and will look similar to this window.  
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The first image shown in the Model Pics window is the Anterior model view, and should 

look like the image shown in the Model area upon startup. The second and third images 

are selected model views using various object formats. 

  

 
 

If the first Model Picture does not match the image shown in the Model area at startup 

(the Anterior model view), review the minimum hardware and software requirements 

described in the section entitled System Requirements. If your system meets those 

requirements, please see chapter 6. 
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If the image in the Model area shows erratic coloration, compared to the Model Picture, 

make sure your computer’s Appearance settings are set to Microsoft Windows’ defaults. 

See Utilizing the Correct Display Settings, or refer to the M2S website at 

http://www.m2s.com/company/contact-us for Preview technical support. 
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Reviewing Patient Information and Original Scan 
Specifications 

 
The Patient tab contains patient statistics and specifications about the original scan from 
which M2S created the 3D model. You can access this information before, and any time 
during, your work with the slices and model. 
 
If you opted to “Blind Patient Data in Preview”, the Patient Specific Software ID:  and 
Patient links will not open when clicked. 
 

Viewing Patient Data 
 

Patient data may include the patient name and age, physician, and the place and date of 

the original scan. This information is extracted directly from the digital data files of the 

patient’s original scan and will vary with the information provided in the digital data. 

 

To read patient data, follow these steps: 

 

1. Click the Patient tab at the top-left of the Main Preview Window. 
 

The Patient tab information appears in the Lists area. 

 

  

2. Click the blue, underlined "Patient:" link. 
 

The Patient Data window opens. It looks something like this: 
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3. Review the information, then close the window by clicking the "Close" 

button in the top-right corner of the window. 

 

  

  Viewing Scan Information 
 

The scan information provides useful information regarding the original patient scan. 

This information is extracted directly from the digital data files of the patient’s original 

scan. 

  

1. Click the Patient tab, then click the blue, underlined "Scan Date:" link. 
 

The Scan Information window opens. It contains the original scan specifications, 

such as scan type, orientation, and slice spacing. This data is helpful in studying 

and marking the slices. 
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2. Review the information, then close the window by clicking the "Close" 

button in the top-right corner of the window. 
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Working with the 3D Model 

 
Using M2S Preview allows users to manipulate the patient-specific model in a variety of 
graphical representations. You can view the anatomy as well as marks and calculations made 
by Preview.  
 

Viewing the 3D Model 
 

1. Select the Mark/Rotate (arrow) tool from the Tool Palette and click-and-hold 
anywhere in the Model area. 
 
The Mark/Rotate tool is used to move the model within the model area and add 
marks within the marks area.  
 
  

2. Rotate the model. 
 
Place the mouse pointer anywhere in the Model area, and then left click and drag the 
mouse. The image turns in any direction in which you “pull” it. You can study the 
model from all viewpoints. L and R are used to indicate the patient’s left and right 
sides, and change as the model is rotated. Alternatively, select the Spin Model 
checkbox found under the Model menu at the top of the screen to automatically 
rotate the model 360 degrees. The model will continue to spin until the checkbox is 
deselected. 
  

3. Change model lighting or background color. 
 
To change the background color of the Model area, select the Model menu and 
choose from the options within the Background Color submenu. To change the 
highlights on the model, select from the options within the Lighting submenu in the 
Model menu. 
 
  

4. Select a model view using Preview’s preset positions. 
 
Click the Views tab, then double-click a view in the Views list; the model turns to 
that view. 
 
  

5. Enlarge the model-image size. 
 
With the cursor in the Model area, hold down the right mouse button, and then drag 
up to zoom in and down to zoom out. 
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6. Notice the various colors in the model. 
The anatomy objects derived from the patient’s scan data are depicted in contrasting 
colors in the model. In vascular models, for example, the colors are: 
 
Note:  The color of anatomy objects may vary. 
  

 Red is both bloodflow and dissection 
 Pink is an endoleak 
 Yellow is thrombus and non-calcified plaque 
 White is calcified plaque and/or stent (post-operative scans only) 
 The color of anatomy objects may vary. 

 
 
  

7. Control the visibility of the anatomy objects. 
 
When you view the 3D model for the first time, the objects appear in an opaque 
format. You can change the format of an object from visible to hidden, and opaque 
to transparent. Select the representative colored button from the Model View bar 
underneath the 3D model and click once or twice to make the object transparent or 
hidden as needed for context. Hold down the right mouse button while moving the 
cursor right or left over the appropriate square to control the degree of transparency. 
 
Note: Making an external portion of the model invisible provides unobstructed 
views of internal portions of the model. 
 
  

8. Set preferences for model viewing for all subsequent Preview sessions. 
 
Select Edit Preferences... from the Help menu. Select background color, model 
spin direction and speed, lighting, visibility of anatomy objects after virtual graft is 
inserted and other options. Click OK or Apply. Preview may need to be restarted for 
all preferences to be set. 
  

C-Arm Views 
 

Clicking the C-Arm Views tab (if available) displays the tool for setting C-Arm View. At 

the left of C-Arm View panel is the list of standard C-Arm views; at the right side is the 

C-Arm View control panel.  

 

1. Click the C-Arm Views tab. 
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2. Select an option for the Standard Views list. 

 

The following standard C-Arm views are available:   

AP: 0,0, LAO: +30, 0; +30,-30; +40,-40; RAO: -30, 0; -30,+30; and -

40,+40. 

 

3. Customize the selection using the Control Panel. 

 

-Right/+Left buttons change the primary angle; +Cranial/-Caudal buttons 

change the secondary angle; the current value of two angles is shown in the 

text fields between buttons.  

 

To set the angle increment, type the desired increment into the Angle 

Increment field.   

 

As the model is rotated in 3D window, the primary and secondary angles 

are updated accordingly.  

 

4.  Perspective and Orthogonal View. 

 

Perspective view 

 Denoted by the following icon: 

 

 
 

In this view the object has apparent scale; the objects appear to get 

smaller and closer together the further away they are. This can 

cause perspective distortion.   

When changing to Perspective view the following window will 

appear.  
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Orthogonal view 

The default view in Preview is Orthogonal.  Denoted by the following icon: 

 
 

In this view the object does not have apparent scale meaning 

objects on the screen will appear the same size no matter how close 

or far away they are.  Orthogonal view is recommended for C-Arm 

calculations.   

When changing to orthogonal view the following window will 

appear.  

 

 
 
  
 

 

Perspective and Orthogonal view 

The pan function is disabled in both views. 

 

Note: When exiting the C-Arm view tab Preview will 

automatically change to Perspective view. 

 

Adding a Custom Model View 
 

While rotating the model, you may find a view or angle that is particularly useful to you. 

For example, you may find an excellent view of two marks between which you have 

calculated a distance. 
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You can save this custom view in your plan document and access it later by clicking the 

Views tab. Your custom views will be available to include in a Preview report. 

 

1. Click the Views tab. 
 

The Views list, showing the six preset views of the 3D model, appears. 

  

2. Rotate the model to find a custom view. 

 

In the Model area, drag the 3D image to the view you want to save. 

  

3. Add the current view to the Views list. 
 

Click Add View. Preview adds the current model view to the list and assigns a 

numerical name to it (“View #1”). 

 

Note: Saving a view in the Views list is particularly helpful after placing marks, 

and after dropping a slice into the model. You may want to save a view that 

exposes the intersection of the slice and the 3D model. See Dropping a Slice into 

the Model, later in this chapter, for more information. 

  

4. Select a view. 
 

To redisplay the saved view or select another model view, double-click the view 

name. Preview updates the model to the selected view. 

  

5. Delete a view. 
 

Click the name of a custom view in the Views list to highlight it. Click Delete. 

 

Note: You cannot delete a pre-rendered view. 

  

6. Save your work. 
 

Once you add views to the Views list, it is a good idea to save your plan 

document file. Select Save from the File menu to save changes and additions to 

the current file, or select Save As if you want to leave your last saved document 

unchanged. 

See the section entitled Saving Your Work for more information about saving 

and naming a plan document file. 

  

You can also leave the Model area open while you work in other areas, which allows you 

to use the model as a reference point while working with slices and in performing 

calculations.  



Chapter 2 - Using Preview  

39 DES-MAN-1-02 Rev. P 

 

Working with Slices 

 
A CT scan can consist of hundreds of slices, depending on slice spacing and scan length. In 
Preview, you can scroll through the complete sequence of CT images displayed at 
standardized intervals, as you might do on the CT console immediately after the scan has 
been performed. In addition, you can enlarge the scanned images and adjust the levels of 
window/level settings for enhanced visualization of anatomic and pathologic details. 
 
In addition, M2S Preview technology provides virtual coronal and sagittal scan data, so that 
views from several planes are accessible to you for viewing. Preview’s commands and tools 
help you manage the vast amount of data available. 
  
Note: In order to view Sagittal and Coronal Slices, You must enable the "Automatically 
Create Sagittal & Coronal .12 slices in Cache" checkbox by clicking Help on the menu bar, 
going to Edit Preferences, and going to the Other tab.  
  

   

Viewing the Axial Slices 
 

1. Displaying Axial, Sagittal, or Coronal slices. 
 
In order to show the slice view desired, do one of the following:  
  

1. Click the red-lettered button below the Slice Controls tab (at the bottom of 
the screen) and select Axial, Sagittal, or Coronal. 
  

2. From the Slices menu, select Set Slice Area, then select Axial. 

 

The last viewed axial slice appears in the Slice area. (This will be slice #0 if 

you have not yet viewed other slices in this window or used the Jump Slice 

tool.) The current slice number appears above the slice image and on the 

Slice # button to the right of the slices popup menu. 
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The slice area showing the view of a Coronal slice  

2. View the slices in sequence. 
 
To view the slices one at a time, you may:  

 Click on the arrows to the right and left of the slice slider, or  

 
The Slice Slider 

  

 Use the roller wheel on your mouse if it is equipped with one. 

3. Scroll through the slices. 
 

To move through more than one slice at a time, click and drag the slider on the 

slider bar.  

 

Dragging the handle to the right end of the slider moves you to the last slice of the 
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scan. 

 

  

4. Go to a particular slice number. 
 

If you know the number of the slice at the area of interest, you can quickly move 

to that slice by opening the Go To Slice # dialog box. You can also use the dialog 

box to move a distance along the slice path in millimeters. To open the dialog 

box, go to the Slices menu and click "Go to slice #" 

 

Type the target slice number in the New Slice # field, or type the number of 

millimeters to move in the Move By Distance (mm) field and select the direction 

to move. Click OK. 

 

Setting Image Quality 
 

There are two options for setting slice image quality. The key difference is that only the 

12-Bit mode allows for Window/Level control. 

 

 

12-bit (high quality) resolution provides access to the original CT scan’s 

12-bit data. By selecting the 12-bit format, you access high quality CT data 

and can adjust the Window/Level settings of the images for enhanced 

discrimination of anatomic and pathologic detail. 

 

Note: The 12-bit images are the full original data from the CT scanner with 

no data loss due to compression. The 8-bit images may have undergone 

some compression to improve screen-drawing speed and storage 

requirements.  

 

High quality, 12-bit images appear more slowly onscreen than the default 8-

bit images. Use the high quality setting for particular studies requiring fine 

discrimination. For general orientation, use the default setting of 8-bit 

resolution for the convenience of a faster screen response. 

  

 

1. Click the Window/Level tab below the Slice area. 

  

2. If prompted, click OK to change to 12-bit slices. 

   

   

 
The Window/Level sliders  
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Within the Window/Level sliders, you can adjust both the brightness 

and contrast of the image, which are represented by Window and Level, 

respectively.  

 

3. Adjust the Minimum and Maximum Levels 
 

Click the Mode button, and from the popup list select Minimum/Maximum. 

The sliders change to Minimum and Maximum controls. These controls 

manipulate the upper and lower limits of pixel values in the slice displays. 

Drag the slider handles to adjust the image. 

   

 
The Minimum/Maximum sliders  

 

4. Restore the default settings. 
 

To return to Preview’s default settings, click Mode, then click Reset to 

Defaults. Preview resets Window/Level and Minimum/Maximum settings 

to the default settings. 

 

  

5. Return to 8-bit slices. 
 

When you are finished with your analysis using the Window/Level 

controls, uncheck the 12-bit checkbox to return to the faster 8-bit slices. 

Zooming in and "Panning" 
 

In order to zoom into a slice within the slice window you can, either press and hold the 

Ctrl key and scroll the mouse or use the zoom in/zoom out buttons located at the bottom 

of the slice window.  

   

 
The Zoom Tools 

 

Once you zoom in, the entire slice may not be visible. In order to maintain your zoomed 

status and examine all parts of the slice, you may either use the scroll arrows or drag the 
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scroll bar. Additionally, you can press and hold the Shift key and click and drag your 

way around the slice.   

 

Note: The slice image can be panned only when the slice image is larger than the size of 

the Slice area. Also note that it might be helpful to increase the window size. To do so, 

click the up arrow at the top-left corner of the Slice area. 

 

Viewing other types of Slices 
 

Using the original axial scan data, M2S provides multi-planar reconstructions — sagittal 

and coronal slice sequences, as well as Aorta, Aorta-Right Iliac, and Aorta-Left Iliac 

slices for applicable vascular studies.  

 

As with the original axial images, you can scroll through the reconstructions, mark them, 

and coordinate them with the model and axial slice views, enabling exceptional visibility 

and delineation of the patient’s anatomy. 

 

To change the slice type, use the menu on the bottom-left corner of the slice window.  

 

 
 

Opening Several Slice Windows at Once 
 

You can view two or more types of slices by opening the additional slices in their own 

windows. For instance, while the Slice area in the Main Preview Window displays Axial 

slices, you can open Sagittal slices in another window. By having several slice views 

open at the same time, you can see an object from several planes using the Jump Slice 

Tool. 

 

To open several windows and resize them to fit on the screen, perform the following 

steps:  

 

1. Reduce the size of the Main Preview Window 
 

Holding the cursor over the right-bottom corner of the window, click and drag it 

to reduce the window size. You may then need to drag the borders of the Slice 
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and Model areas to keep both areas in view. 

  

2. Open another slice window. 
 

From the Slices menu, select Open New Slice Window. From the submenu, 

select the type of slice you want to view. The second slice window opens on the 

right side of the screen. 

  

3. Reduce the size of the second window. 
 

If you are using a smaller screen, you may want to reduce the size of the second 

window. Click and drag any of the window’s borders to reduce the window size. 

  

4. Move the window. 
 

Holding the cursor on the window’s title bar, drag the window to the desired 

location. 

  

5. If you wish, open and resize other slice windows. 
 

You can fit about four windows on the screen and still view the model. 

Locating Corresponding Slices: Jumping Slices 
 

In Preview, you can quickly access original and reformatted slices that correspond to a 

specific location on the 3D model or on a particular scan slice. 

 

1. With the Model area and any combination of slice windows open, select the 

Jump Slice (+) tool from the Tool Palette.  

  

2. Position the Jump Slice tool (+) over the model image or slice image at the 

location of interest and click.  
 

A yellow cross indicator (+) appears on the model at that location. Preview 

updates the slice number of all slice windows so that they display the same 

location as indicated on the model. The yellow cross indicators on the slice 

images and in the model indicate the same location. 
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3. Hiding the yellow cross indicator.  
 

If you want to hide the cross indicator from view, uncheck the Crosshair Visible 

checkbox in the Marks tab. 
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"Dropping" a Slice into the 3D Model 

 
In Preview, Drop Slices are helpful in many tasks. For example, use them to:  
  

 Determine the location of 3D-model boundaries in slices. 
  

 Define the area of an object for which you want to measure volume or path length. 
  

 Locate a scan slice to calculate vessel diameter. 
  

 Define the area of a flow channel for which you want to calculate a path length 
(centerline calculation or VirtualGraft). 
  

Setting the Current Slice in the Model 
 

   

The Current Slice in Model command displays the active window’s current slice in the 

3D model image. (If you have more than one window open, the active window is the 

topmost one.) As you step through slices, Preview automatically updates the model with 

the current slice, showing the 3D context of the slice. 

  

1. Prepare the model.  
 

Click the Anatomy tab, and select an appropriate format (transparent or opaque, 

visible or hidden) for each of the model’s objects. 

  

2. Set the Slice area to display the type of slices you want to drop into the 

model. 
 

In the Main Preview Window: 

  

With the Slice Controls tab selected, click the red-lettered 

button. Select the slice type from the popup menu. 

  

3. Activate the Current Slice in Model command. 

  

Toggle the Current Slice button in the model view bar.  

  

4. Move through the slices. 
 

Preview updates the model with the slice currently displayed in the Slice area. 
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Locate a slice you want to “drop” in the model by scrolling or stepping through 

slices. 

Turning off the Current Slice 
 

When you want to discontinue the current slice display in the model, you can Toggle the 

Current Slice button on the model view bar.  

Dropping a Slice into the Model 
 

The Drop Slice Into Model command places the current scan slice (from the last active 

Slice window) into its corresponding position in the 3D model. The same Drop Slice 

remains in the model, even if you view a different slice in the Slice area. 

 

Dropping a slice helps you view and verify the relationship of the scan slice to the 3D 

model. You will use dropped slices later in this chapter for volume and centerline 

(bloodflow path) calculations. 

  

1. “Drop” the slice into the model. 
 

Press Ctrl-D, or select Drop Slice Into Model from the Slices menu. M2S 

Preview sets the two-dimensional slice into the 3D model. You can make 

additional format changes to the model with the slice in place. 
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Examples of a drop slice in a 3D model 

  

2. Rotate the model. 

  

3. Click the Drop Slices tab to display the Drop Slices list.  
 

When you drop the slice into the model, the slice becomes an object, and its name 

appears in the Drop Slices list. 

 

Make the drop slice visible or hidden using the Visible checkbox. 

  

Setting Slice Transparency 
 

Drop slices in an opaque format may obstruct your view of the model and of the 

relationship of slice to model. You can set the slice to a partially transparent format.  

 

To change a slice’s transparency level, perform the following steps: 
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1. Select Set Drop Slice Trans... from the Slices menu. 

 

The Drop Slice Transparency Level # dialog box opens. 

  

 
Drop Slice Transparency Level # dialog box 

  

2. Change the transparency setting.  
 

Type a transparency range between 0 (opaque) and 255 (maximum transparency). 

This level corresponds to 8-bit pixel values and not to Hounsfield units.  

 

The transparency level affects all Drop Slices and Current Slices in the model. 

Deleting Drop Slices 
 

To remove a dropped slice from the model, perform the following steps:  

  

1. Click the Drop Slices tab to display the Drop Slices list. 

  

2. Select the slice in the Drop Slices list. 

  

3. Click the Delete button. 
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Marking Slices 

 
Marks can help you with treatment planning and education. You can plot incisions, mark 
perimeters of objects, and measure angles and distances. Your marks become part of the 
plan file that you can reopen at a later time and use as an aid to pre-surgery planning and 
patient consultation. 
 
The marks made on one slice are immediately visible in their corresponding locations in the 
axial, coronal, sagittal, and oblique slice windows. When you place marks on slices, the marks 
also appear in the 3D model, but may or may not be visible in the model, depending on its 
position and the transparency of the model’s objects. Model transparency is described earlier 
in the section Working with the 3D Model. 

Creating and Viewing Marks 
 

 
1. Place marks on a slice. 

 
Point the mouse arrow to any part of the slice image and click the mouse button. A 
small blue circle in a yellow square is placed on the slice. 
 
Note: If you have deselected “Draw Mark Selection Box” in Edit Preferences, the 
yellow box will not be visible. To resize a mark, use the right-click method of 
resizing marks described under Resizing, Formatting, and Naming Marks. 
 
You can create marks on all slice types. A mark placed on an axial slice appears 
simultaneously on its corresponding coronal, sagittal, and iliac (if applicable to the 
patient data) slices, but is visible only when the corresponding slice number is 
displayed. 
 
Marks also appear in the 3D model. As you place new marks in slice windows, the 
model is updated with the additional marks. 

 
A yellow box surrounds the newly created mark.  

  

2. View the marks in the Marks list.  
 

Click the Marks tab to display the Marks list. 

 

The Marks list shows all the marks you have placed on slices. The marks are 

numbered in the order in which you created them. 
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3. Place more Marks 
 

Click on a slice to place more marks. Note that the Marks list updates to display 

the new marks. 

Selecting a Mark 
 

When you select an existing mark, a yellow box appears around that mark in all slices 

and in the model. If the mark is outside the 3D view (from side to side or up and down, or 

“behind” the view), the yellow “selection box” does not appear. 

 

You may want to select an existing mark for several reasons, for example: 

  

 To edit the mark for color, size, or transparent format. 

  

 To give it an identifying name. 

  

 To quickly identify it in the model, using the selection box. 

  

 To delete the mark. 

  

 To Jump Slice all slice windows to the location of that mark. 

  

5. Select a mark. 
 

To select a mark, do one of the following: 

  

 Position the mouse pointer directly over the mark in the slice area or 

window, and click. A yellow box appears around the mark to indicate that 

it is the currently selected mark. 

  

 In the Marks list, click on the name of the mark you want to select. 

Locating Corresponding Slices: "Jumping Slices to a 
Mark" 

 
In Preview, you can quickly view other slices that correspond to a specific mark. 

 

1. Open slice windows 
 

Using the Open New Slice Window command in the Slices menu, open any 

combination of slice windows — axial, coronal, sagittal, or, if applicable, the 

right or left iliac slice window. For information on opening and placing several 

windows onscreen, see the section Opening Several Slice Windows at Once.  
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2. Select a mark.  
 

Click the Marks tab to display the Marks list, then click on the mark name to 

select it.  

  

3. Select the Jump Slices to Mark command. 

  

 In the Marks list, click the Jump button.  

  

 From the Slices Menu, select Jump Slices to Mark 

 

The Jump Slices to Mark command updates all slice windows to display the slices that 

correspond to the location of the selected mark. 

 

If the mark selected is not close enough to any slice in an oblique slice window, that 

window will not update, and the selected mark will not appear in them. 

Deleting Marks 
 

1. Delete a mark.  

  

Click the mark name in the Marks list, then click the Delete button or press 

the Delete or Backspace key. 

 

Delete a mark removes it permanently from all slice windows, the model, 

and the Marks list.  

 

Note: If you attempt to delete a mark that is part of a calculation, Preview 

will alert you before deleting the mark. 

 

2. Delete all marks. 
 

To delete all marks, click the Delete All button in the Marks tab. 

Moving Marks 
 

You can move a mark in a Slice image by dragging it with the mouse. 

 

1. Select the Mark/Rotate tool. 

  

2. Click the mark to select it. 

  

3. Click in the center of the mark and drag it to a new position. 
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Preview updates the mark position automatically on the model and all other slices. 

Preview also updates any calculations that involve the relocated mark. 

Changing How Marks Are Displayed 
 

1. Display or hide marks. 
 

From the Marks menu at the top of the screen, select the Display Marks 

checkbox to display all marks in all slice windows. To hide—not delete—the 

marks, uncheck the Display Marks checkbox. Another way to access commands 

that change a mark's display is to click the Marks tab, then click the Display 

button below the Marks list. 

 

To display or hide marks in the model, click the mark button in the Model View 

panel until the desired format is reached. 

  

2. Show mark names or hide mark names. 
 

From the Marks menu, select the Display Mark Names checkbox to display the 

full names of all existing marks in all slice windows. At this point, the names 

probably read “Mark 1,” “Mark 2,” and so on. Instructions on customizing and 

editing mark names are provided in the next section, Resizing, Formatting, and 

Naming Marks. To hide mark names, uncheck the Display Mark Names 

checkbox. (Even if marks are hidden, their names appear in the Marks list.) 

  

3. Change mark visibility in the model. 
 

To hide mark names in the model, click once or twice on the mark button in the 

Model View panel.  

 

To change whether or not the mark names and diameters are displayed in the 

model, use the Show Mark Names and Show Mark Diameters checkboxes 

under the Model menu. 

  

4. Display or hide mark diameters. 
 

From the Marks menu, select the Display Mark Diameters checkbox. The 

diameter of a mark appears next to the mark in all slice windows. To hide mark 

diameters, uncheck the Display Mark Diameters checkbox. Click on the mark 

button in the Model View panel to hide mark names and diameters in the model. 

  

5. Display marks as filled or hollow in slice images. 
 

From the Marks menu, select either the Marks Filled or Marks Hollow option. 

 

For some tasks, like making distance measurements, using Marks Hollow is 
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preferable because the marks will not obscure the area beneath them. 

  

6. Display or hide mark selection box. 
 

To change whether or not the mark selection box is shown, toggle the Show 

Mark Selection Boxes checkbox under the Help->Edit Preferences->Other 

menus. 

Resizing, Formatting, and Naming Marks 
 

Assigning a custom color, size, and descriptive name to marks is useful when you want to 

differentiate anatomy, emphasize certain features, or depict multiple surgical options. 

 

1. Click the Marks tab to display the Marks list. 

  

2. Double-click a mark name in the list.  
 

The Edit Mark dialog box opens: 

  

   

 

 
Edit Mark Dialog Box 

  

3. Edit the name of the mark.  
 

Select a Type from the drop-down menu and either accept the default name or 

enter a new name in the Name field. 

 

Note: You need to select a Type in order for your mark or calculation to appear in 

the Design Your [Manufacturer Name] Graft or Custom Graft Builder window 
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when using the VirtualGraft feature. 

  

4. Change the size of the mark. 
 

To change a mark size, while in the slice, click on the mark to select it. A yellow 

box frames the mark. Right-click and hold anywhere inside the mark, and drag the 

box to the desired size. 

 

 
A mark enlarged to outline the perimeter of a vessel.  

 

5. Change the size of the mark using the Auto size tool. 
 

The size of the mark can also be changed by using the Auto size tool.  Select the 

Auto Size button and the current mark will enlarge to the size of the vessel on 

which it is located.  For more detailed instructions on how to use Auto size, see 

Calculating Vessel Diameters. 

  

6. Change the color of mark.  
 

In the Edit Mark dialog box, click the box to the right of the Color button to open 

a drop-down list of colors. Click the color you want to select. 

 

To select a color not in the list, click other.... In the color grid that appears, select 

the desired color, then click OK. When prompted, name the new color you 

selected, then click OK. The new color now appears in the drop-down list. 

  

7. Adjust the transparency level of the mark. 
 

Select the Transparent checkbox to make the mark semi-transparent in the 

model and slices. Click in the % entry field and type a value between 0 and 100 to 

set the level of transparency. 

 

If, for some reason, you do not want this mark to appear in the model and slices, 
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uncheck the Visible checkbox (which is selected by default) to turn off visibility. 

  

8. Click OK to make your changes to the mark. 
 

Changes you make in the Edit Mark dialog box apply only to the current mark. To 

apply the new properties you have selected to all subsequent marks, click Save 

Defaults before clicking OK. 

 

For instructions on calculating distance and angles between marks, see Creating 

Calculations between Marks. 
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Bookmarking Slices 

 
A bookmark saves a reference to a particular slice number. Bookmarked slices and any 
accompanying comments become part of your document plan, and are printed as part of the 
Preview report you generate. 
 

Creating a Bookmark 
 

To bookmark a slice, perform the following steps: 

 

1. Scroll to a slice you want to bookmark. 

  

2. Add a bookmark. 

 

Click the Bookmarks tab to open the Bookmarks list and click the Add 

Bookmark button.  

 

The slice number appears in the Bookmarks list.  

  

3. Add a comment to the bookmark. 

 

To note why the bookmarked slice is significant, add a comment. Click the 

Comment button, and in the Bookmark Comment dialog box, type a description 

of the bookmarked slice. Click OK. The comment appears next to the bookmark 

in the Bookmarks list. All bookmarks and their comments become part of the 

patient plan and report. 

Using Bookmarks 
 

After you create a bookmark, you can quickly access the bookmarked slice.  

 

1. Click the Bookmarks tab to open the Bookmarks list. 

  

2. In the Bookmarks list, double-click the desired bookmark. 

 

Preview displays the bookmarked slice in the Slice area. 

  

Deleting a Bookmark 
 

1. Select the bookmark in the Bookmarks list you want to delete. 
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2. Click the Delete button, or press the Delete or Backspace key. 
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Saving Your Work 

 
Even if you are not finished working with the current patient data, it’s a good idea to save 
your current marks, drop slices, etc. in a plan document file. You can continue to modify and 
update the plan and save it again with subsequent additions and changes. 
 
It is important to save your work often so that new data changes are stored in the name file 
and to safeguard against data losses due to unusual circumstances such as system failure or 
low memory.  
 

What You Can Save 
 

The following components are saved in the plan document file:  

 

 My Notes - Notes you make regarding your findings, patient assessment, 

and recommended treatment plan. Access from the My Notes link in the 

Plan tab (see below). 

  

 Marks - All the marks on all scan slices, including their colors, sizes, and 

names. 

  

 Calculations - Measurements taken between marks or between slices, and 

shown in the Calculations list. 

  

 Bookmarked Slices - All the slices that are bookmarked. 

  

 Drop Slices - All the current Drop Slices and Current Slices in the model. 

  

 Views - Any custom views of the 3D model that you added to the Views 

list. 

  

 Virtual Grafts - All the VirtualGrafts you have built.  

  

Your data file will also contain an internal pointer to the patient-specific data for which 

the plan was created, to ensure that a plan document is not accidentally mismatched with 

another M2S Patient Specific Software data set. 

 

Making Notes 
 

As you work with your patient plan, you can make notes regarding your findings and 

recommendations in the My Notes window. 
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1. Click the Plan tab. 

  

2. In the Plan tab, click the My Notes link to open the My Notes window. 

  

3. In the My Notes window, type information pertinent to the plan. 

  

4. Copy information from other windows or applications. 
 

You can also copy text from the Model Pics or Scan Data windows or from a 

word-processing document into the My Notes window. Highlight the desired text 

and press Ctrl-C. In the My Notes window, press Ctrl-P to insert the text. 

 

The text in My Notes becomes part of your patient plan and Preview report. 

 

 

 In Preview, select Help, Edit Preferences, Other, and select “Keep My Notes 

Dialog Always on Top” if preferred.   

Saving and Naming the Plan 
 

1. From the File menu, select Save As. 
 

The Save dialog box opens 

 

.  
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2. Select the folder where you want to save your plan. 

 

Preview will open to the default plan folder and give your plan a default name. If 

you would like to set up a new folder or rename the plan proceed to step 3, 

otherwise click the Save button. 

  

3. Click the Create New Folder icon (the third icon to the right of the Look in: 

drop-down list). 

 

An item named “New Folder” appears in the Save dialog box list. You may need 

to scroll the file list to find it. 

  

4. Name the new folder. 

 

Click the folder icon to the left of the words “New Folder.” Click on the words 

“New Folder” so that the blue highlighting disappears. Now drag the mouse 

cursor over the words “New Folder” so they are again highlighted, then type a 

new name for the folder (i.e., “Preview Plans”). Press the Enter key to save the 

folder name. When the line with the new name is highlighted in blue, folder 

naming is complete. 

  

5. Assign a name to your plan. 

 

Double-click your new folder’s icon to “move” into it. In the Save dialog box, 

click in the File name: field and type a name for your plan. As with any 

windows-based file name, the file name can be up to 255 characters long and 

must exclude any of the following characters:  

/ \ > < * . ? “ | : ; 

  

6. Save the file. 

 

Click the Save button. 
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Ending the Preview Session 

 

Exiting the Program 
From the File menu, select Exit to exit the Preview program. 
 
If you have not saved additions changes to marks, calculations, drop slices, or other 
information, Preview prompts you to do so now. 
  

Opening New Patient Data 
 

You must end your current Preview session and restart the program in order to open a 

different patient data set. 

 

1. Quit Preview by Selecting Exit from the file menu 

  

2. Double Click the Preview shortcut icon on the desktop to load Preview and 

choose a new study.  

 

Opening a Saved Plan  
 

Preview requires that you open the study before navigating to your saved plan. 

 

1. Double Click the Preview shortcut icon on the desktop to load Preview and 

choose a study. 

2. Click File and Open  

3. Navigate to the folder that your Plan was saved in.  Note:  Preview defaults to 

saving Plans in the Preview Plans and Reports folder. 

4. Select the plan that corresponds with the study you have opened in Preview. 

5. Your saved measurements will now appear in the study. 
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Chapter 3 - Creating Calculations and 
Aortic Aneurysm Planning 

Creating Calculations between Marks 

 
Using Preview’s powerful Calculation tools, you can measure distances, angles, and 
percentage stenosis between marks, as well as calculate the volume and length of a 
bloodflow channel. Calculations become part of your plan document file and appear in 
Preview reports, providing vital information about vessel diameters and lengths, and 
relationships between objects. 
 
When using Preview to assess a patient's anatomy for potential stent graft repair, it is 
important to remember that several factors can impact the accuracy of the measurements 
made on the scan data - scan quality, time passed since scan, stent graft used and deployment 
technique, to name a few. Therefore, be sure to consider all factors and use caution when 
evaluating length measurements made on pre-operative anatomy. For more information, see 
the section entitled VirtualGraft™ Method for Sizing Bifurcated Stent Grafts.  

Measuring Distance Between Marks 
 

In this section you will learn how to:  
 

 Calculate the distance between two marks.  
  

 Measure the distance between anatomy objects, such as lesion to critical structures, 
to assist in surgery planning.  
  

 Measure the diameter of a blood vessel or other structure.  
  

 Measure the length of an anatomical feature.  
 
The steps are as follows:  
  

1. Open the "Marks" Menu by clicking on the "Marks" tab and verify that the 
Display Mark Names checkbox is checked.  
  

2. Select the New Distance Calculation  command.  
 

You can select the command by going to the Calculations tab, Clicking on the 

New Calculation button and finally clicking on New Distance Calculation.  

 

The Edit Distance Calculation dialog box opens  
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Preview automatically assigns the last two marks selected in the current session as 

the First and Second Marks. If you want marks other than those Preview has 

selected, follow steps 4 and 5. 

  

3. Choose the First Mark. 
 

Click in the First Mark field to open a drop-down list of current marks. Click to 

highlight the correct mark. 

  

4. Choose the Second Mark. 
 

Click in the Second Mark field and select the second mark.  

 

Note: The two marks you select do not have to appear on the same slice or slice 

type. 

  

5. Name the calculation. 
 

Select a Type from the drop-down menu and either accept the default name or 

enter a new name in the Name field. 

 

Note: You need to select a Type in order for your mark or calculation to appear in 

the Design Your [Manufacturer Name] Graft or Custom Graft Builder window 

when using the VirtualGraft feature. 
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6. Choose formats for the model display. 
 

Preview will display the distance between the two marks as a green graphic in the 

model (after you click the OK button in step 7). 

 

To change how the graphic is displayed, make the following selections: 

  

 From the Color drop-down menu, select the color of the graphic. 

  

 Use the Display checkboxes to show the graphic as Visible or hidden, and 

Transparent or opaque. If you make the graphic transparent, you can type 

the percentage of transparency in the % field. 

  

 Select Line or Tube. 

  

The tube format is useful for endovascular pre-surgery planning. See the 

section entitled Aortic Aneurysm Treatment Planning for more 

information.  

 

Note: If your marks appear on a single slice, Preview displays the 

calculation on the slice image as well as in the model. The Color, Visible 

and Transparent formats apply to the calculation graphic in both the slice 

and model. 

  

7. Click the OK  button to perform the distance calculation. 

  

8. View the calculation’s result. 
 

Click the Calculations tab to view the Calculations list. The Calculations 

list displays the result of the measurement between the selected marks. 

  

 
Calculation result displayed in the Calculations list.  

  

Note: If you move a mark that is part of an existing calculation, Preview 

automatically recalculates the distance for you and updates the information 

in the Calculations list and in the model. 
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Editing a Calculation 

 
If you need to change the endpoints of a calculation or its display properties, double-click 
the calculation in the Calculations list.  When the Edit Distance Calculation dialog box 
opens, make changes and click OK. 

Resize a Mark to Measure Diameter of an Object  
 

By moving and sizing a mark appropriately, you can adjust the size of a mark to “fit” an 

object or structure depicted in a scan slice. This method is especially useful for estimating 

an object or vessel diameter, and can be used as an alternative to the Distance 

Calculation. 

 

1. Find the slice that provides the optimum view of the object. 
 

Scroll or step through slice images to locate the best view. 

  

2. Place a mark on the object. 

  

3. Click the Marks tab to open the Marks list. 

  

4. Click Display to open the drop-down menu. If not already selected, click to 

select the Marks Hollow option. 

  

5. Point to the “handle” on the lower right of the yellow frame around the 

mark, click and drag the frame to the size you want. 
 

You can also right-click any point on the mark and resize it by dragging the 

mouse forward and backward.  

 

If you would like to adjust the placement of a mark, left-click the mark itself and 

drag it in any direction to adjust the location of mark on the slice.  

  

6. Open the Edit Mark dialog box. 
 

Double-click on the mark to open the Edit Mark dialog box. The measurement in 

the Diameter entry box will indicate the approximate diameter of the object.  

 

The number to the right of the Diameter entry box is the French (or catheter) size 

of the diameter; the Volume number refers to the volume of the mark’s sphere in 

cubic centimeters. 

  

7. Name the mark. 
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To name the calculation, select a Type from the drop-down menu and either 

accept the default name or enter a new name in the Name field. Click OK. 

Creating a Diameter Measurement Between Two Marks  
 

1. Place a mark on the perimeter of the vessel, and continue holding down the 

left mouse button. 

  

2. Drag the arrow to the opposite side of the perimeter to measure the vessel’s 

diameter. 
 

The mark becomes smaller to make it easier to place. 

  

3. Release the mouse button. 
 

The Edit Distance Calculation dialog box opens, and similarly to the Mark-to-

Mark method, you can change format for model display. 

 

To name the calculation, select a Type from the drop-down menu and either 

accept the default name or enter a new name in the Name field. 

  

4. Click OK to perform the distance calculation. 
 

The calculation will appear in the Model area, Slices area and the Calculations 

list.  

  

5. Change the mark location. 
 

Click in the Slices area to select a mark. Click again in the center of the mark and 

drag it to the new location.  

 

Note: When you move a mark that is part of an existing calculation, Preview will 

automatically recalculate and display the results in the Model and Slices areas and 

the Calculations list. 

  

Measuring the Percentage of Stenosis Between Marks 
 

Calculating the percentage of stenosis in an aneurysm is an often used and useful 

calculation. Creating one of these calculations is very simple: 

  

1. Open the Marks menu. 

  

2. If the Display Marks Names checkbox is not checked, select it. 
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Displaying the mark names on the slices and model will help you select the right 

marks for your distance calculation. 

  

3. Select the New Stenosis Calculation command. 

  

 From the Calculations menu, select New Stenosis Calculation. 

   

The Edit Stenosis Calculation Dialog box opens. 

 

 
  

Preview automatically assigns the last two marks selected in the current 

session as the First and Second Marks. If you want marks other than those 

Preview has selected, follow steps 4 and 5. 

  

4. Choose the First Mark. 
 

Click in the First Mark field to open a drop-down list of current marks. 

Click to highlight the correct mark. 

  

5. Choose the Second Mark. 
 

Click in the Second Mark field and select the second mark.  

 

Note: The two marks you select do not have to appear on the same slice or 

slice type. 

  

6. Name the calculation. 
 

Select a Type from the drop-down menu and either accept the default 

name or enter a new name in the Name field. 

  

7. Click the OK  button to perform the stenosis calculation. 

  

8. View the calculation’s result. 
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Click the Calculations tab to view the Calculations list. The Calculations 

list displays the result of the measurement between the selected marks. 

   

 
A calculation result is displayed in the Calculations list  

  

Note: If you resize a mark that is part of an existing calculation, Preview 

automatically recalculates the percentage stenosis for you and updates the 

information in the Calculations list. 

  

9. Save your plan file. 
 

The calculations become part of the plan document file. Select Save from 

the File menu to save the new calculation in your current plan. 

Calculating a Multiline Length 
 

With Preview’s Multiline Calculation feature, you can define and measure a path simply 

by putting down a set of marks. Preview lets you adjust the path by moving any of its 

marks, and then automatically recalculates the multiline length. 

 

Note: We recommend opening a new plan document before you place your 

marks for a Multiline Calculation. Doing so will expedite the selection of 

marks in the calculation dialog box, as you will see in step 10. 

  

1. From the File menu, select New to start a new plan document. 
 

If prompted, save or discard your old plan document. 

  

2. Click the Anatomy tab to view the list of anatomy objects. 
 

If necessary, adjust the transparency of the model objects and use the 

Zoom tool to get the best view of the anatomy you want to mark. 

  

3. Select the Jump Slice tool from the Tool Palette 

  

4. View the slice image. 
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The cross (+) in the slice corresponds to the position of the Jump Slice 

tool in the model. 

  

5. Place a mark on the model by using the Mark/Rotate tool.  

  

6. Make modifications to the mark. 
 

Adjust the mark size, if necessary, by dragging the handle on the mark 

frame. 

 

The size you select for your marks determines the diameter of the “tube” 

that will depict the multi-line path. See step 14 below. 

 

Adjust the position of the mark, if necessary, by dragging it to the correct 

location (click and hold the mouse button over the mark, then drag). 

 

Double-click the mark to open the Edit Mark dialog box. If you want, 

make further adjustments to the mark size. (To apply your size 

specifications to subsequent marks, click Save Defaults.) Click OK. 

  

7. Repeat steps 4 through 7 to place more marks to complete the path to 

use for the multi-line calculation. 

  

8. Click the Calculations tab to open the Calculations list. 

  

9. Click New Calculation, then select New Multiline Calculation.  
 

The Edit Multiline Calculation dialog box opens. 
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The Edit Multiline Calculation dialog box  

  

10. Select marks for the multiline calculation. 
 

If you opened a new plan document in step 1, click the Add All button in 

the Edit Multiline Calculation dialog box. Preview lists all existing marks 

from the current plan, in order of creation. 

 

If you don’t want all existing marks to be included in this calculation, you 

can use Add All, then selectively delete the marks you want omitted. 

Alternatively, you can add one mark at a time: Select a mark from the 

Mark to Add drop-down list, then click on the Add Mark button. Repeat 

for each mark you want to add. 

  

11. Click Sort Marks. 
 

The Sort Marks button sorts the marks into a coherent single path that 

typically represents the shortest path between the set of marks, unless the 
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geometry of the marks is quite complex. 

  

12. If the sequence of marks provided by the Sort Marks button is not the 

order you prefer, re-sequence the marks. 
 

In the Edit Multiline Calculation dialog box, select the mark you want to 

re-sequence, then use the Move Up and Move Down buttons to place it in 

the correct sequence. 

 

Note: You may want to select Display Mark Names from the Marks menu 

to view mark names in both the slice and model images. 

  

13. Remove a mark from the multiline path. 
 

In the Edit Multiline Calculation dialog box, select the mark you want to 

remove, then click the Remove button to delete it from the calculation. 

  

14. Choose formats for the model display. 
 

Preview will display the multiline in the model (after you click the OK 

button). Use the options at the bottom of the Edit Multiline Calculation 

dialog box to define the line format you want: Color, Visible or Hidden, 

Line or Tube, Transparent or Solid. 

 

If you choose a Transparent format, you can specify the level of 

transparency in the % entry box, or use the default value of 50%. 

 

Note: Tube diameters are determined by the size of the marks used in the 

calculation. 

  

15. Name the calculation. 
 

Type a descriptive name for the calculation in the Name field. 

  

16. Click OK to perform the multiline calculation. 
 

The multiline path you defined appears in the model, and its measured 

length appears in the Calculations list. 

 

Note: If all the marks in your multiline calculation are in one slice, the 

angle also appears in the slice. 

  

17. Save your plan file. 
 

The calculations become part of the plan document file, select Save from 

the file menu to Save your plan.  
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Editing a Multiline Calculation 
 

If you need to change the calculation’s marks or properties at a later time, double-click 

the calculation in the Calculations list to open the Edit Multiline Calculation dialog box, 

or right-click the calculation in the Calculations list and select Edit from the popup 

menu. Make changes and click OK. 

 

For more information on changing the properties of an existing calculation, see the 

section entitled Making Changes to a Distance or Angle Calculation.  

 

  

Measuring an Angle Created by Three Marks 
 

   

Preview measures the angle created by three selected marks. Depending on the anatomy 

you are marking, you may prefer to use the Jump Slice tool in the model to determine the 

best positions for your marks. 

 

See steps 1 through 6 in the section entitled Calculating a Multiline Length  if you require 

instructions on how to use the Jump Slice tool to position your marks. 

 

1. Select Axial, Sagittal, Coronal, or any of the oblique slices from the Slice 

Controls tab near the bottom of the screen. 

  

2. Place a mark on the target slice by clicking anywhere on the slice itself. 

  

3. Make modifications to the mark. 
 

Adjust the mark size, if necessary, by dragging the handle on the mark frame. 

 

Note: The size you select for your marks determines the diameter of the “tube” 

that will depict the angle, if you choose to have the calculation displayed as such 

in the model. See step 8 below. 

 

Adjust the position of the mark, if necessary, by dragging it to the correct location 

(click the center of the mark, then drag). 

 

Double-click the mark to open the Edit Mark dialog box. If you want, make 

further adjustments to the mark size, and click OK. To apply your size 

specifications to subsequent marks, click Save Defaults, then click OK. 

  

4. Place two more marks. 

  

5. From the Marks menu, make sure that Display Mark Names is selected.  
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6. Select the New Angle Calculation command. 

  

 From the Calculations menu, select New Angle Calculation tab. 

  

   

The Edit Calculation dialog box opens:  

  

 
The Edit Calculation dialog box  

  

7. Select the First Mark, Second Mark, and Third Mark for your angle 

calculation. 
 

Preview automatically sets the First Mark, Second Mark, and Third Mark to the 

last three marks selected in the current plan document. You can click on the Mark 

drop-down lists to select other marks. 

  

8. Choose formats for the model display. 
 

Preview will display the angle in the Model area (after you click the OK button). 

Use the options at the bottom of the Edit Angle Calculation dialog box to define 

the format you want: Color, Visible or Hidden, Line or Tube, Solid or 

Transparent. 

 

The tube format is useful to visualize your calculation. If you choose a 

Transparent format, you can specify the level of transparency in the % entry box, 
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or use the default value of 50%. 

  

9. Name the calculation. 
 

Select a Type from the drop-down menu and either accept the default name or 

enter a new name in the Name field. 

  

10. Click OK to perform the angle calculation.  

 

 
Sample angle calculation display in model 

 

 

 
The calculation as it appears in the Calculations list 

 

Note: If you move a mark that is part of an existing angle calculation, 

Preview recalculates the angle for you and updates the information in the 
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Calculations list. Also note that if all three marks in your angle calculation 

are in the same slice, the angle also appears in the slice image. 

 

11. Save your plan file. 
 

The calculations become part of the plan document file. Press Ctrl-S (or 

select Save from the File menu) to save the new calculation in your 

current plan. 

Making Changes to a Distance or Angle Calculation 
 

After you view a distance, angle, or multiline calculation in the model, you may want to 

fine-tune it. You can move marks and change the model display for an existing 

calculation. 

 

1. Reposition a mark that is part of an existing calculation. 
 

With the default cursor (the arrow) click to select a mark in the slice area or 

window. Click again in the center of the mark and drag it to a new position. As 

you move the mark, you can view the change to the calculation in the model. 

 

When you move a mark that is part of an existing calculation, Preview 

automatically recalculates the distance, angle, or multiline for you and displays 

the result in the Calculations list. 

  

2. Change the tube diameter. 
 

To change the diameter of a calculation’s tube graphic, resize the marks that make 

up the calculation. Change the size of a mark in one of the following ways:  

  

 Double-click the mark name in the Marks list or double-click the mark in 

the slice. In the Edit Mark dialog box, click in the Diameter field. Type a 

number to define the new diameter of the selected mark in millimeters 

(mm). 

  

 In the slice, click the mark to select it. A yellow box frames the mark. 

Click and hold the mouse pointer over the “handle” of the frame and drag 

the box to the size you want. 

  

3. Change the model display of an existing calculation. 
 

In the Calculations list, double-click on the calculation you want to change. 

Alternatively, right-click on the calculation in the Calculations list and select 

Edit. In the edit calculation dialog box, make the necessary changes to the display 

settings. 

 



Chapter 3 - Creating Calculations and Aortic Aneurysm Planning 

77 DES-MAN-1-02 Rev. P 

For example, you can change the calculation graphic’s color, its transparency, and 

whether it appears as a line or a tube. 

  

4. Click OK to make your changes to the calculation. 

Make area and perimeter calculation 
 

 

In Preview tool bar click the polygon tool icon to activate the tool. Once the tool is 

activated the icon is highlighted.  

 

1. Creating a Polygon 

 

Left click the mouse in the slice window in the desired position to start to construct the 

polygon.  This point will be the start vertex of the polygon.  Once the start vertex has 

been created keep clicking around the boundary of the feature, each click will create a 

new handler; until the start vertex has been reached at this point the polygon will be 

closed.    Once the polygon is closed the handlers will turn blue and the area and 

perimeter results will be displayed in the slice window and the calculations tab.  The 

more handlers that are created the greater the accuracy of the polygon. 

 

2. Reshape the Polygon 

Once the polygon has been closed the handlers can be dragged and replaced to reshape 

the polygon.  This is done by moving the mouse over a handler were the pointer turns to a 

hand shape.  At this point the handler can be moved to the desired position. 

 

3. Other tips 

1. An unfinished polygon can be canceled by pressing the Esc. Key.  

2. To delete the last handler press the delete key. 

3. The handlers can only be repositioned when the polygon selection tool is 

activated. 

4. The area and perimeter calculation can be saved and reloaded by saving the 

plan. 

Deleting a Calculation 
 

 

1. Click the Calculations tab. 

  

2. Select the calculation you want to delete by clicking it in the list. 

  

3. Right-click the calculation and select Delete from the popup menu, or click 

the Delete button, or press the Delete or Backspace key. 

 

Note: Deleting a calculation will not delete its associated marks. 
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Calculating Volumes 

 
In this section, you will use axial slices to determine the volume of scanned objects. When 
performing volume calculations, you will use these areas of the Preview interface: 
 

Slices-The slice images provide a useful frame of reference for marking and 

measuring anatomical objects. 

 

Model-Using the Jump Slice tool, you can quickly locate slices that 

correspond to key locations on the model. Using the Current Slice in Model 

tool, you can verify the relationship of the slice and your marks to the 3D 

model. You can rotate the model and its dropped slice, and view it from all 

angles. After performing the calculation, Preview displays the calculation 

as a graphic in the model. 

 

Calculations List-Where Preview displays the calculation result. 

 

Note: Volume calculations are not available in all studies.  

Calculating the Volume of an Object 
 

By locating axial slices at the top and bottom of a region of an object in the 3D model, 

you can estimate the volume of that object. Caution: The accuracy of a volume 

calculation is dependent on a number of factors, including the object’s size, the 

complexity of the object’s shape, and how clearly the object can be delineated in the slice 

images. An alert with this caution will appear the first time you do a volume calculation. 

 

To calculate an object’s volume, perform the following steps: 

 

1. Click the Volume tab below the Slice area. 
 

If you are not on an Axial slice, Preview will automatically switch to the axial 

slice view.  

  

2. Click the button next to Slice 1: to “enter” the current slice. 
 

Preview will “enter” the current slice number into the volume calculation dialog 

box for you, as you’ll see later. 

  

3. Locate the axial slice at the bottom of the object or object region; click the 

button next to Slice 2: to enter that slice. 
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4. Click the Object button to choose the anatomy you want to measure. 
 

From the Object button’s popup list, select the anatomy objects you want to 

measure.  

 

The selections include individual anatomy objects or combinations of several 

objects. The resulting volume of the object(s) between the upper and lower axial 

slices appears in cubic centimeters (cc) in red to the right of the Object button. 

  

5. To record the calculation, click the Record button. 
 

The Edit Volume Calculation dialog box appears.  

   

 
  

Edit Volume Calculation Dialog Box 

 

The slice numbers you entered appear in the First Axial Slice and Second 

Axial Slice fields. 

 

6. Select a Type from the drop-down menu and either accept the default 

name or enter a new name in the Name field. 

  

7. If you need to, change either of the following: 

  

 The object to be measured (use the Object(s) drop-down list)  

  

 The first and second axial slice numbers 
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8. Choose formats for the model display. 
 

Choose a color from the Color drop-down list, and select the Visible 

checkbox to see a frame in the model that shows the area being measured. 

If you do not want to see the frame, uncheck the Visible checkbox. To 

make the calculation transparent, check the Transparent checkbox. You 

can specify the level of transparency in the % entry box, or use the default 

value of 50%. 

  

9. Click OK to perform the calculation. 

  

10. View the calculation results in the Calculations list and in the model. 

 

 
The volume calculation in the Calculations list 

 

 

 
Frame indicating the volume calculation in the model 
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The frame around the model serves as a visual reality check for the selected area 

of measurement. The top and bottom show the bounds for the volume. The sides 

are set to the widest and deepest parts of the overall object (or the combined set of 

objects). 

 

See the section entitled Measuring Aneurysm Volume for a specific application 

of the volume calculation feature. 
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Calculating Centerlines or Path Length 

 
You can measure the length along the centerline of a bloodflow channel in Preview 

vascular applications. Preview calculates the curving path length between two slices that 

you specify. 

 

Note: Use only Aorta, Aorta-Right Iliac, or Aorta-Left Iliac slices for 

Centerline calculations. 

  

1. Select the oblique slices you want to use for the Centerline calculation. 
 

In the Slice Controls tab, click the red-lettered button to open the drop-down 

menu. Select Aorta, Aorta-Right Iliac, or Aorta-Left Iliac. 

  

2. Click on the "Cur Slice" checkbox. 
 

The current slice appears in the model. As you scroll through slices, Preview 

automatically updates the model with the current slice in the Slice area. 

  

3. Move through the slices to locate the slice at the top of the segment for which 

you want to calculate a centerline. 
 

You may gain an enhanced understanding of this slice location by rotating the 

combined model and slice in the Model area. 

  

4. “Enter” the slice in the length calculation. 
 

Click the Centerline tab. Click the button next to Slice 1: to enter the number of 

the current slice. Preview will “enter” the current slice into the Edit Centerline 

Calculation dialog box. 

 

Note: If you want to keep the slice image in the model, select Drop Slice Into 

Model from the Model menu.  

  

5. Scroll through the slices to locate the slice at the bottom of the segment you 

want to measure. 

  

6. “Enter” the second slice in the length calculation. 
 

Click the Centerline tab. Click the button next to Slice 2: to enter the number of 

the current slice. Preview will “enter” the current slice into the Edit Centerline 

Calculation dialog box. 

 

The resulting length (in millimeters) along the center line between Slice 1 and 
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Slice 2 appears in red to the left of the Record button. 

  

7. To record the calculation, click the Record button. 

  

8. Select New Centerline Calculation from the Calculations menu to open the 

Edit Centerline Calculation dialog box. 
 

The Edit Centerline Calculation dialog box opens. 

   

   

 
The Edit Centerline Calculation dialog box 

 

9. Select a Type from the drop-down menu and either accept the default name 

or enter a new name in the Name field. 

  

10. Choose formats for the model display. 
 

Use the format options below the slice number fields to choose the color of the 

calculation graphic, its visibility and transparency, and whether it appears as a line 

or tube. 

 

The Tube format is useful for endovascular pre-surgery planning. In the diameter 
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entry box, enter the appropriate value. 

  

11. In the Edit Centerline Calculation dialog box, click OK to perform the 

calculation. 
 

The Centerline segment you defined appears in the model. The Centerline 

measurement appears in the Calculations list. 

Viewing a Calculation 

 
In the calculations list, highlight the calculation that you want to view.  The Preview pane 

will show the marks associated with the calculation. 

Making Changes to a Calculation 

 
After you view a calculation in the model, you may want to make changes to its model 

display settings. For example, you may need to change the display from a Line to a Tube, 

or adjust the diameter of the tube. The Tube format can be useful in visualizing objects 

such as endovascular grafts or idealized blood-flow channels. 

 

1. Change the model display of an existing calculation. 
 

In the Calculations list, double-click on the calculation you want to change. In the 

Edit Centerline Calculation dialog box, make the necessary changes to the model 

display settings. 

 

To change the diameter of the tube, click in the Diameter field and type a new 

number. 

  

2. Click OK to make your changes to the calculation. 

Deleting a Calculation  

 
 

1. Click the Calculations tab to open the Calculations list. 

  

2. Click on the calculation you want to delete to select it. 

  

3. Right-click the calculation and select Delete from the popup menu, or click 

the Delete button, or press the Delete or Backspace key. 
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Aortic Aneurysm Treatment Planning 

 
Preview may be used to determine treatment strategies for patients with aortic aneurysms. 
 In this section, we describe how to use Preview in abdominal aortic aneurysm treatment 
planning for endovascular procedures. While the following scenarios provide examples of 
using Preview in vascular surgery planning specifically, the methods and tools described can 
be applied to many areas of surgery planning. 



Preview User's Manual 

86 DES-MAN-1-02 Rev. P 

Making Calculations for Bifurcated Stent Grafts 

 
The following sections provide step-by-step instructions for making a standard series of 
calculations for evaluating patients and sizing bifurcated stent grafts. Refer to the diagram 
below and its labels for the sequence and location of calculations required. The label names 
mirror the suggested names for calculations in this section's instructions. 

 
Standard Data Points for 

Bifurcated Stent Grafts 

Prox Dia 1 = Starting point 

of graft  

 

Prox Dia 2 = Distal end of 

the proximal neck 

 

PL1 = Proximal neck 

Length 

 

PD1-AO-BIF = Length* 

from the renals to the aortic 

bifurcation 

 

AO-RCIA 2 = Length* 

from the renals to the left 

hypogastric 

 

AA MAX D = Maximum 

AAA sac diameter.  

 

MIN/AO-BIF = Minimum 

aorta diameter at point of 

bifurcation 

 

RCIA 1 =  Beginning point 

of right iliac sealzone 

 

RCIA 2 = End point of the 

right iliac sealzone 

 

RCIA SEALZONE = Zone 

in right iliac artery where 

graft must form a pressure 

seal 

 

LCIA 1 = Beginning point 

of left iliac sealzone  

 

LCIA 2 =  End point of left 

iliac sealzone  

 

LCIA SEALZONE = Left 

iliac sealzone 

s  
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Calculating Vessel Diameters 
 

Measure vessel diameters using only Aorta, Aorta-Right Iliac, or Aorta-Left Iliac 

slices. Because these slices are at a right angle to the bloodflow path, they present a truer 

cross-sectional diameter. Do not use Axial slices. 

 

Preview offers four methods for measuring vessel diameters: 

  

 Resizing Mark Method and the Auto size tool are effective for vessels 

with circular shape. 

  

 Mark-to-Mark and Click-Drag-Release methods should be used for 

calculating non-circular vessel cross-sections. 

Resizing Mark Method 
 

1. In the Slice Controls tab, select Aorta, Aorta-Right Iliac, or Aorta-Left Iliac. 

  

2. In the slice, add a Mark in the center of the lumen. 

  

3. Resize the mark to fit the aorta diameter. 
 

Drag the handle at the bottom-right of the yellow box that surrounds the mark. To 

move the mark, click at its center and drag it to the desired location. 

  

4. Double-click the center of the mark. 
 

The Edit Mark dialog box opens. 

  

5. Note the diameter, select a Type from the drop-down menu and either accept 

the default name or enter a new name in the Name field. 

  

6. Click OK. 

Auto size Method 
 

1. In the Slice Controls tab, select Aorta, Aorta-Right Iliac, or Aorta-Left Iliac. 

  

2. In the slice, add a Mark in the center of the lumen. 

  

3. To get an Auto size of the bloodflow, check the Bloodflow box in the Marks 

Tab and then select the Auto Size button. 
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4. To get an Auto size of the lumen, make sure the Bloodflow box in the Marks 

Tab is unchecked and then select the Auto Size button. 

  

5. There are five different ways to invoke the Auto Size function.  It is located 

on the Marks pull-down window at the top of the Preview pane, the Marks 

tab, right-clicking on the mark in the Marks tab, the Edit Mark window and 

by typing ctrl-m. 

  

6. Currently, the Auto size Method only works for marks that have been 

created in Preview.  It does not work for marks downloaded from PEMS.   

  

Mark-to-Mark Method 
 

1. Place a mark on the edge of the vessel. 

  

2. Double-click in the center of the mark to open the Edit Mark dialog box. 

  

3. In the Diameter field, type “3 mm”, or other desired small diameter. 

  

4. Click Save Defaults, then click OK. 

  

5. Place a second mark on the vessel opposite the first one. 
 

Click and drag either mark to reposition as needed. 

  

6. From the Calculations menu, select New Distance Calculation. 
 

The Edit Distance Calculation dialog box opens. You can change the way the 

calculation is displayed in the Model and Slices area.  

  

7. Select a Type from the drop-down menu and either accept the default name 

or enter a new name in the Name field. Click OK. 
 

The diameter calculation appears in the Calculations tab. 

 

Note: You need to select a Type in order for your mark or calculation to appear in 

the Design Your [Manufacturer Name] Graft or Custom Graft Builder window 

when using the VirtualGraft feature. 

Click-Drag-Release Method 
 

Use this method for calculating non-circular vessel cross-sections. 
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1. Place the arrow on the edge of the vessel. 

  

2. Click and hold the left mouse button and then drag the arrow to the opposite 

edge if the vessel.  

  

3. Release the mouse button. 
 

The Edit Distance Calculation dialog box opens. 

  

4. Select a Type from the drop-down menu and either accept the default name 

or enter a new name in the Name field. Click OK. 
 

The diameter calculation appears in the Calculations tab. 
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Calculating Vessel Centerline Lengths 

 
You can calculate the centerline of bloodflow by specifying the upper and lower Aorta or 

Aorta-Iliac slices of the segment you want to measure.  

 

Note: Use only Aorta, Aorta-Right Iliac, or Aorta-Left Iliac slices for 

centerline calculations. Do not use Axial slices. 

 

Typing Slice Numbers in the Dialog Box 
 

One method for performing a centerline calculation is to type the appropriate slice 

numbers in the slice fields in the calculation dialog box. Perform the following steps: 

 

1. From the Calculations menu, select New Centerline Calculation. 

  

2. From the Slices drop-down menu, select Aorta Slice, Aorta-Left Iliac Slice, or 

Aorta-Right Iliac Slice. 

  

3. Enter slice numbers in the First Slice and Second Slice fields. 

  

4. Select a Type from the drop-down menu and either accept the default name 

or enter a new name in the Name field. Click OK. 
 

The calculation appears in the Calculations tab. 

 

Note: You need to select a Type in order for your mark or calculation to appear in 

the Design Your [Manufacturer Name] Graft or Custom Graft Builder window 

when using the VirtualGraft feature. 

  

Using Slice Buttons in the Centerline Tab 
 

Another method for performing centerline calculations is to scroll to the appropriate 

slices, and enter their numbers using buttons in the Centerline tab of the Slice area and 

Slice windows. 

 

1. Scroll through slices or use the Jump Slice tool to locate the slice at the top of 

the segment for which you want to calculate a centerline. 

  

2. To enter this slice number in the length calculation, click the Centerline tab, 

then click the button to the right of Slice 1. 
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3. Scroll through to select the slice at the distal end of the segment you want to 

calculate. 

  

4. In the Centerline tab, click the button to the right of Slice 2. 
 

The length (in millimeters) along the centerline of the two selected slices appears 

in red to the left of the Record button. 

  

5. To record the centerline distance calculation, click the Record  button. 
 

Preview automatically enters the slice numbers in the Edit Centerline Calculation 

dialog box. 

  

6. Select a Type from the drop-down menu and either accept the default name 

or enter a new name in the Name field. Click OK. 
 

The calculation appears in the Calculations tab. 

 

Note: You need to select a Type in order for your mark or calculation to appear in 

the Design Your [Manufacturer Name] Graft or Custom Graft Builder window 

when using the VirtualGraft feature. 

  

Visualizing a Graft 
 

Any centerline calculation can be visualized as a tube within the vessel. This provides a 

way to test the fit of a graft. To display the centerline as a tube, perform the following 

steps: 

 

1. After entering the slice numbers for the centerline calculation, select the 

Tube display option in the Edit Centerline Calculation dialog box. 

  

2. In the diameter field, enter the diameter. 

  

3. Click OK. 

  

The model displays the centerline calculation as a tube. 

 

For complex grafts, use Preview’s VirtualGraft feature. See the section entitled 

 VirtualGraft™ Method for Sizing Bifurcated Stent Grafts for more information on 

VirtualGrafts and how to interpret the model display. 
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Evaluating the Proximal Neck 

 
Accurate understanding and measurement of the minimum access diameter of the iliac 

artery may be used for planning an endovascular repair. Use Preview’s oblique slices, 

which are perpendicular to the bloodflow channel to examine the true lumen of the iliac 

arteries. 

 

Determining the Starting Point for the Graft 
 

1. Click the red-lettered button in the Slice Controls tab and select Aorta-Left 

Iliac or Aorta-Right Iliac. 

  

2. Select the "Cur Slice" checkbox. 
 

The current slice appears in the model. Rotate the model for optimal views of 

both the slice location and the renal arteries. 

  

3. Press and hold the Ctrl key to select the Jump Slice tool, and click on the 3D 

model at the approximate proximal starting point of the graft. 
 

It is usually best to click on the model just below the renal arteries. Scroll slices 

up or down to refine the slice position. 

  

4. Click the Centerline tab below the Slice area, then click the button to the 

right of Slice 1. 
 

Preview will enter the selected slice as Slice 1 for this and subsequent centerline 

calculations. This entered slice number will remain Slice 1 until you enter another 

slice in the Slice 1 field. 

  

Calculating the Proximal Length Diameters 
 

In the aorta slices, vessel cross-sections are more circular than elliptical, and therefore, 

allow more accurate measurement of the diameter than the axial slices. 

 

1. Find an aorta slice that provides a representative view of the neck. 

  

2. Add a mark in the center of the Aorta, Aorta-Left Iliac, or Aorta Right Iliac 

slice. 
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3. Resize the mark so that it covers the aorta. 
 

To move the mark, click its center and drag it to the desired location. 

  

4. Double-click the mark to open the Edit Mark dialog box. 
 

Select a Type, such as “Aortic Diameter at Renals”, from the drop-down menu. 

Either accept the default name that appears in the Name field, or type in a 

descriptive name for the mark, such as “Prox Dia 1.” This is the diameter of the 

proximal end of the proximal neck. 

 

(Prox Dia 1 is illustrated in the diagram in the section entitled Making 

Calculations for Bifurcated Stent Grafts .) 

  

5. Click Save Defaults, then click OK. 
 

Alternatively, use the Mark-to-Mark or Click-Drag-Release methods described 

earlier in the chapter. See the section entitled Calculating Vessel Diameters. 

Determine the Distal End of the Proximal Neck 
 

1. Scroll down through slices to examine the quality of the proximal neck. 

  

2. To visualize suspected changes in aortic diameter, place a mark in the center 

of the aorta on any slice. 
 

Because you changed the default diameter in step 5 above, the marks will be 

equal to the diameter measured for the Prox Dia 1 and will simplify visualizing 

diameter changes. To remove marks, select them and press the Delete or 

Backspace key. 

  

3. Locate the slice at the distal end of the proximal neck. 
 

This will be the beginning of the aneurysm, or, in the case of conical necks, it is 

the location of the maximum aortic diameter recommended for the graft system 

used. 

  

4. Add a mark on the slice in the center of the aorta and resize it to measure the 

diameter at the distal end of the proximal neck. 

  

5. Double-click the mark to open the Edit Mark dialog box. 
 

Select “Aortic Diameter at Distal End of Proximal Neck” from the Type drop-

down menu. In the Name field, type a descriptive name for the mark, such as 

“Prox Dia 2” or accept the default name. Click OK.  
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(Prox Dia 2 is illustrated in the diagram in the section entitled Making 

Calculations for Bifurcated Stent Grafts.) 

  

6. Click the Centerline tab below the Slice area, then click the button to the 

right of Slice 2. 
 

Preview will enter this slice number in subsequent centerline calculations. This 

entered slice number will remain as Slice 2 until you enter another slice in the 

Slice 2 field. 

  

 
Drop slices marking the two ends of the proximal neck 

 

 

Record the Proximal Neck Length 
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The distance between the two selected slices appears in red to the left of the Record 

button. 

  

1. Click the Record button to record the calculation. 
 

The Edit Centerline Calculation dialog box opens. 

  

2. Select “Proximal Aortic Neck Length” from the Type drop-down menu. In 

the Name field, type “PL1” or accept the default name. Click OK. 
 

The Calculation list appears in the Lists area, displaying the calculation result. 

(PL1 is illustrated in the diagram  in the section entitled Making Calculations for 

Bifurcated Stent Grafts.) 

Calculating Lengths of Conical Proximal Necks 
 

To determine the proximal neck length for conical necks, use the following method to 

locate the distal end of the proximal neck for a specific graft system. 

 

1. Review the manufacturer’s specifications and your calculation of Prox Dia 1 

(the aortic diameter at the top of the proximal neck). 
 

From these, determine the maximum aortic diameter recommended, taking into 

consideration the manufacturer’s oversizing recommendation. For example, a 28 

mm graft may have a minimum oversizing specification of 2 mm. Therefore, 26 

mm is the maximum recommended aortic diameter within the anticipated 

sealzone. 

  

2. On an iliac slice in the proximal neck area, click a mark in the center of the 

aorta. 

 

Note: A graft’s sealzones are the areas at the ends of the graft, where good 

apposition is required to effectively seal the aneurysm from arterial pressure. 

 

  

3. Double-click the mark, and in the Edit Mark dialog box, enter a diameter 

equal to the maximum aortic diameter for the graft system. 

  

4. Click Save Defaults, then click OK. 
 

All subsequent marks will have the diameter you entered in step 3 until you 

change the diameter and click Save Defaults again. 

  

5. View the mark in relation to the aorta. 
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If the mark is larger than the aorta, the distal end of the proximal neck may be 

lower. Select the mark and press the Delete or Backspace key to remove it. 

  

6. Scroll through the slices to a lower location within the proximal neck. 

  

7. Click marks on slices until you find a slice where the mark size is equal to the 

aortic diameter. 
 

This is the distal end of the proximal neck. 

  

8. Double-click the mark to open the Edit Mark dialog box. 
 

Select a Type from the drop-down menu. In the Name field enter a name for the 

mark, such as “Prox Dia 2” or accept the default name. Click OK. 

  

9. Click the Centerline tab below the Slice area, then click the button to the 

right of Slice 2. 
 

Preview will enter this slice number in subsequent centerline calculations. (Slice 1 

is still set to the slice marking the top end of the graft, as entered in the section 

entitled Determine the Starting Point for the Graft). 

  

10. Click Record to record the calculation. 
 

The Edit Centerline Calculation dialog box opens. 

  

11. Select “Proximal Aortic Neck Length” from the Type drop-down menu. In 

the Name field, type “PL1” or accept the default name. Click OK. 
 

The Calculation list appears in the Lists area, displaying the calculation result. 
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Mid-Aneurysm Calculations 

 
Use the following steps to measure the maximum diameter of the aneurysm sac, the 

minimum lumen diameter at the aortic bifurcation, and the centerline length from the 

renals to the bifurcation. 

 

Maximum AAA Sac Diameter 
 

To measure the maximum diameter of the aneurysm, perform the following steps: 

 

1. Rotate the model to get the best view of the width of the aneurysm sac. 

  

2. Press and hold the Ctrl key to select the Jump Slice tool, and click on the 

widest section of the aneurysm in the 3D model to jump to the corresponding 

slice. 

  

3. Utilize the Mark-to-Mark or Click-Drag-Release methods to obtain the 

diameter calculation. See the section entitled Calculating Vessel Diameters.  

  

4. Select “Maximum AAA Diameter” from the Type drop-down menu. In the 

Name field, type a descriptive name such as “AAA Max D” or accept the 

default name. Click OK. 

  

Alternatively, you may use the Resizing Mark method described earlier in this section. 

See Calculating Vessel Diameters. 

Minimum Clearance Diameter at Aortic Bifurcation 
 

To determine the minimum clearance for the graft, you must measure the smallest lumen 

diameter at the aortic bifurcation. Perform the following steps: 

 

1. Scroll through the slices to find the slice with the smallest lumen diameter in 

the region of the aortic bifurcation. 

  

2. Add a mark on the aorta in the slice. 

  

3. Size the mark to cover the aorta’s perimeter. 

  

4. Double-click the mark to open the Edit Mark dialog box. 

  

5. Note the diameter, select “Aortic Bifurcation Diameter” from the Type drop-

down menu, and type a descriptive name such as “AO-BIF” in the Name 

field, or accept the default name. Click OK. 
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Alternatively, utilize the Mark-to-Mark and Click-Drag-Release methods described 

earlier in the chapter. See the section entitled Calculating Vessel Diameters. 

Centerline Length: Renals to Aortic Bifurcation 
 

To calculate the length of the centerline of bloodflow from the renals (top end of the 

graft) to the aortic bifurcation, perform the following steps: 

 

1. Click the Centerline tab below the Slice area. 

  

2. Use the Jump Slice tool to find the slice just above the aortic bifurcation. 

  

3. In the Centerline tab, click the button to the right of Slice 2 to enter the slice 

number in the centerline calculation. 
 

(In previous steps, Slice 1 was set to the slice marking the top of the graft.) 

  

4. Click the Record button. 

  

5. In the Edit Centerline Calculation dialog box, select “Renal to Aortic 

Bifurcation” from the Type drop-down menu and type a descriptive name 

for the calculation (such as “PD1-AO-BIF”) or accept the default name. 

Click OK. 
 

(PD1-AO-BIF is illustrated in the diagram in the section entitled Making 

Calculations for Bifurcated Stent Grafts.) 
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Right Iliac Calculations 

 
This section steps you through right iliac calculations. The next section focuses on left 

iliac calculations. 

Centerline Length: Renals to Right Hypogastric 
 

To measure the centerline length from the renal arteries to the right hypogastric artery, 

perform the following steps: 

 

1. If Slice 1 is not set to the slice marking the top of the graft, enter that slice in 

the Slice 1 field as shown in Determine the Starting Point for the Graft on in 

the section entitled Evaluating the Proximal Neck.  

  

2. Scroll through the slices to a location just above the takeoff of the right 

hypogastric artery. 
 

This slice marks the location of the distal end of the maximum graft length 

possible without occluding the hypogastric artery. 

  

3. Click the Centerline tab, then click the button to the right of Slice 2 to enter 

the slice into the length calculation. 

  

4. Click the Record button. 

  

5. In the Edit Centerline Calculation dialog box, select “Renal to Right 

Hypogastric” from the Type drop-down menu and enter a name for the 

calculation such as “AO-RCIA 2” or accept the default name. Click OK. 
 

(AO-RCIA 2 is illustrated in the diagram in the section entitled Making 

Calculations for Bifurcated Stent Grafts). 

Calculate RCIA Diameter 
 

To calculate the centerline diameter of the right iliac artery, perform the following steps: 

 

1. Rotate the model to get the best view of the right iliac artery. 

  

2. Identify the potential sealzone segment of the vessel. 
 

This segment should be free of the aneurysm and have a relatively uniform 

diameter. 
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3. Scroll through slices to the distal end of the available sealzone. 

  

4. Add a mark in the center of the vessel and expand it to measure the 

diameter. 

  

5. Double-click the mark to open the Edit Mark dialog box. 

  

6. Note the diameter, select “Representative Diameter at Right Common Iliac” 

from the Type drop-down menu and name the mark (i.e., “RCIA 2”) or 

accept the default name. Click OK. 
 

(RCIA 2 is illustrated in the diagram in the section entitled Making Calculations 

for Bifurcated Stent Grafts.) 

Calculate Graft Length to Reach RCIA 2 
 

To calculate the length of the graft from its proximal end to the sealzone in the right iliac 

artery, perform the following steps: 

 

1. Click the Centerline tab, then click the button to the right of Slice 2. 

  

2. Click the Record button. 

  

3. In the Edit Centerline Calculation dialog box, select a Type from the drop-

down menu, name the calculation (i.e., “PD1-RCIA 2”) or accept the default 

name. Click OK. 

Calculate RCIA Sealzone Length 
 

In the three steps above, you entered the slice that marks the end of the graft as Slice 2. 

To enter the slice marking the top end of the sealzone and then calculate the length of the 

sealzone, perform the following steps: 

 

1. Scroll through slices to the proximal end of the available right iliac sealzone. 

  

2. In the slice, add a mark on the artery and resize it to measure iliac diameter. 

  

3. Double-click the mark to open the Edit Mark dialog box. 

  

4. Note the diameter, select a Type from the drop-down menu, name the mark 

(i.e., “RCIA 1”) or accept the default name. Click OK. 

  

5. Click the Centerline tab, then click the button to the right of Slice 1. 
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6. Click Record. 

  

7. In the Edit Centerline Calculation dialog box, select “Right Iliac Sealzone” 

from the Type drop-down menu and name the calculation (i.e., “RCIA 

SEALZONE”) or accept the default name. Click OK. 
 

(RCIA 1 and RCIA SEALZONE are illustrated in the diagram in the section 

entitled Making Calculations for Bifurcated Stent Grafts.) 
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Left Iliac Calculations 

 
This section provides step-by-step instruction for performing left iliac calculations. 
Important: Before you can take measurements in the left iliac artery, you must switch to the 
Aorta-Left Iliac slices. 

Centerline Length: Renals to Left Hypogastric 
 

To measure the centerline length from the renal arteries to the left hypogastric artery, 
perform the following steps: 
 

1. From the Slices menu, select Set Slice Area, then Aorta-Left Iliac. 
  

2. Click the Calculations tab, and view previous calculations to identify the slice 
number used as the starting point for the proximal graft. 
  

3. Press Ctrl-G to open the Go to Slice #... dialog box. 
  

4. In the dialog box, enter the slice number and click OK. 
 
The Aorta-Left Iliac slices move to the selected slice. 
  

5. In the Centerline tab, click the button to the right of Slice 1 to enter the slice 
into the length calculation. 
  

6. Scroll through the slices to a location just above the takeoff of the left 
hypogastric artery. 
 
This slice marks the distal end of the location of the maximum graft length possible 
without occluding the hypogastric artery. 
  

7. In the Centerline tab, click the button to the right of Slice 2 to enter the slice 
into the length calculation. 
  

8. Click the Record button. 
  

9. In the Edit Centerline Calculation dialog box, select “Renal to Left 
Hypogastric” from the Type drop-down menu and enter a name for the 
calculation such as “AO-LCIA 2” or accept the default name. Click OK. 
 
(AO-LCIA 2 is illustrated in the diagram in the section entitled Making 
Calculations for Bifurcated Stent Grafts) 

Calculate LCIA Diameter 
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To calculate the diameter of the left iliac artery, follow the instructions in Calculate 

RCIA Diameter in the previous section , but use the Aorta-Left Iliac slices. Select 

“Representative Diameter at Left Common Iliac” from the Type drop-down menu. Give 

the measurement a descriptive name such as “LCIA 2” or accept the default name. 

 

(LCIA 2 is illustrated in the diagram in the section entitled Making Calculations for 

Bifurcated Stent Grafts) 

Calculate Graft Length to Reach LCIA 2 
 

To calculate the length of the graft from its proximal end to the sealzone in the left iliac 

artery, follow the instructions in Calculate Graft Length to Reach RCIA 2 in the 

previous section, but use the Aorta-Left Iliac slices. Give the calculation a descriptive 

name such as “PD1-LCIA2” or accept the default name. 

Calculate LCIA Sealzone Lengths 
 

To calculate the length of the sealzone in the left iliac artery, follow the instructions in 

Calculate RCIA Sealzone Length in the previous section, but use the Aorta-Left Iliac 

slices. Select “Left Iliac Sealzone” from the Type drop-down menu. Give the calculation 

a descriptive name such as “LCIA SEALZONE” or accept the default name. 

 

(LCIA SEALZONE is illustrated in the section entitled Making Calculations for 

Bifurcated Stent Grafts) 
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Evaluating Iliac Access 

 
You can use Preview to estimate the difficulty of passing an endovascular delivery 

system through the ilio-femoral canal using the iliac access evaluator feature. To use this 

feature, perform the following steps: 

 

Using the Diameter Evaluator Feature 
 

1. Click the Diameter Evaluator tab. 
 

Preview will place tubes along the centerlines of both the RIL and LIL at the 

diameter indicated. 

  

2. Use the sliders to change the size of the tubes. 
 

Preview operates in millimeters, but will show an approximate outer diameter in 

French. This is calculated using the conversion 3 FR = 1 mm. Check the 

specifications of your sheath manufacturer to make sure this is the appropriate 

conversion. 

  

3. Use the visibility slider and the color drop-down menu to change the 

transparency and color of the tubes. 

   

Use the iliac access tool to designate areas of concern for further evaluation using the 

oblique slices.  

 

Using Slices to Evaluate Iliac Access 
 

To use slices to evaluate iliac access, perform the following steps: 

 

1. Click the red-lettered button below the Slice area, and from the popup menu 

select Aorta-Right Iliac or Aorta-Left Iliac. 

  

2. Scroll through the slices and examine the true lumen for calcification and 

minimum diameter. 

  

3. Measure the diameter of the iliac artery at intervals as needed. 

  

4. As necessary, select the Cur Slice checkbox for perspective. 

Aortic Diameter 
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The Diameter Evaluator can also be used to estimate the diameter of the aortic neck. To 

do this, perform the following steps: 

 

1. Turn on the checkbox next to Aortic Diameter. 

  

2. Use the sliders to change the size of the tubes. 
 

The aortic slider functions in the same way as the Iliac Access sliders. Read the 

description above to see how to use it. 

 

The aortic diameter evaluator should be used to find areas of the anatomy that warrant 

further review using the slices. Use the Jump Click feature to switch quickly to the 

relevant slice. 
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Measuring Proximal Neck Angulation 

 
To calculate angulation in areas of tortuosity, you can use a Preview feature that 

measures the angle created by three selected marks. 

 

Using the Angle Calculation 
 

To measure angulation, perform the following steps: 

  

1. Click the red-lettered button below the Slice area, and from the popup menu 

select Aorta. 

  

2. Press and hold Ctrl to select the Jump Slice tool, and click on the aorta in the 

model at the top of the proximal neck. 

  

3. On the corresponding slice, click a mark in the center of the lumen. 

  

4. Rotate the model to best visualize maximum angulation and the area of acute 

angulation from the proximal neck and the main body of the aneurysm. 
 

You are looking to see where the line “breaks.” 

  

5. Use the Jump Slice tool and click on the model at the point of the “break.” 

  

6. On the corresponding slice, add a mark in the center of the lumen. 

  

7. Use the Jump Slice tool and click on the model near the aortic bifurcation. 

  

8. On the corresponding slice, place a mark in the center of the lumen. 
 

This third mark completes the last leg of the angle measurement. 

  

9. From the Calculations menu, select New Angle Calculation. 

  

10. Select a Type from the drop-down menu. Accept the default name, or give 

the calculation a descriptive name such as “PROXIMAL NECK ANGLE.” 

Click OK. 
 

The calculation result appears in the Calculations list and in the model. 
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\ 

A proximal neck angle displayed in the model 
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Calculating C-Arm Gantry Correction for Parallax Error 

 
To confirm position of AAA stent grafts within in the proximal neck, especially in 

patients exhibiting significant proximal neck angulation, the c-arm gantry correction tool 

may be used.  This tool is located on the slice control tabs below the slice window. 

 

Note: C-Arm Tool. Preview includes a special C-Arm creation tool. This tool is located 

on one of the slice control tabs below the slice window.  

 

If you would like to create this angle yourself, here are the steps to calculate the C-Arm 

gantry correction angle in the critical cranio-caudal plane: 

 

1. Click the Views tab, and double-click Anterior in the Views list. 

  

2. Rotate the model downward so you have a direct view of the proximal neck. 

  

3. With the Jump Slice tool, click the mid-line of the aorta in the model, at the 

level of the lowest renal artery. 
 

Or you can click the anticipated location of the proximal landing point for your 

graft. 

  

4. Click the red-lettered button in the Slice Controls tab, and from the popup 

menu select Sagittal. 
 

Adjust the magnification and then pan to visualize the sagittal plane of the 

proximal neck and the location of the Jump Slice cross-hair indicator (+). The 

cross-hair indicator marks the desired implantation level at the top of the graft. 

  

5. Place the cursor a short vertical distance above the cross hair in the slice and 

click a mark. 

  

6. Add a second mark directly on top of the cross hair. 

  

7. Add a third mark in a position that is perpendicular to the aorta at the 

location of the second mark. 

  

8. From the Calculations menu, selection New Angle Calculation. 
 

The Edit New Angle Calculation dialog box opens. 

  

9. Select “C-Arm Gantry Correction Angle” from the type drop-down menu. 

Accept the default name, or give the calculation a descriptive name such as 

“C-ARM CORRECTION.” 
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10. Select the Tube display option, and click OK. 
 

The angle calculation result appears in the Calculations list. 

  

11. Evaluate the correction angle in the model. 
 

The angle is sometimes easier to see in the model. Rotate the model to a lateral 

view. To adjust the aiming of the angle correction, click and drag the third mark 

in the slice while observing its location in the model. The result in the 

Calculations list updates to reflect any changes made to the angle. 

 
A correction angle in the model, shown with the sagittal Current Slice selected  
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Measuring Aneurysm Volume 

 
Measuring aneurysm volume, given identifiable and consistent anatomical fiducial marks, 
may allow the user to compare changes in the volume of anatomy at sequential intervals. 
 

Calculating Aneurysm Volume 
 

To calculate the volume of an aneurysm, perform the following steps: 

 

1. Select one of the following as the standard anatomical fiducial option for 

your calculation: 

  

 The lowest renal artery takeoff to the aortic bifurcation; or 

  

 The lowest renal artery takeoff to the right or left hypogastric artery 

takeoff 

  

2. Click the Volume tab below the Slice area. 

 

 If not already selected, Axial slices appear in the Slice area. 

  

3. Select the relevant object you’re studying from the object drop-down menu. 

  

4. Select the Jump Slice tool, and click on the model just below the renal 

arteries. 

  

5. Study the corresponding axial slice and refine the axial slice location if 

necessary. 

  

6. Click the button next to Slice 1 to enter the slice number. 

  

7. Scroll through the axial slices or use the Jump Slice tool to find the axial slice 

at the lower fiducial point (the aortic bifurcation or the hypogastric takeoff). 

  

8. Click the Slice 2 button to enter the slice number. 

  

9. Click the Record button. 

 

The Edit Volume Calculation dialog box opens. 

  

10. Select a Type from the drop-down menu. Accept the default name or enter a 

new name in the Name field. Click OK. 
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The resulting volume calculation appears in the Calculations list. In the model, a 

green box around the selected area serves as a reality check of the measurement. 
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Inner and Outer Curve Lengths 

 
Purpose:  In highly angulated locations along a vessel, the purpose of this feature is to 

provide the user with a better depiction of how a stent graft will deploy based on tortuous 

anatomy.  Determining the behavior of a stent graft will provide a user with additional 

information during pre-operative case planning to support stent graft sizing decisions. 

 

Functionality:   A user can place a tube graft in the bloodflow lumen to approximate the 

extent that a user would like to cover with a stent graft; specifying start and stop slice 

locations as well as a tube diameter.  Using the inner/outer curve feature, a user can then 

run a centerline, an inner curve line, and outer curve line down the length of the tube 

graft.  Each of these lines independently reports a specific length measurement.  The 

centerline length measurement can be compared to each of the inner and outer curve 

length measurements using an angulation ratio, simply a ratio between the inner and outer 

curve lengths.  This ratio can be used to:  1) assess the degree of angulation in a particular 

location and 2) assess how likely a graft will be to twist and compress once implanted. 

 These assessments can allow a user to better anticipate the behavior of the graft prior to 

implant and help a user make a more informed decision about how to size the graft based 

on a user’s knowledge of seal zones as well as graft component twisting and torsion. 

.   

Creating a Calculation using the Inner and Outer Curve 
Tool 

 
1. From the Calculations tab or the main menu, select New Curve Calculation. 

 

The Edit Curve Calculation dialog box opens. You can change the way the 
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calculation is displayed in the Model and Slices area.  

 
2. Type: select measurement of Inner Curve or Outer Curve or Inner/Outer Curve 

3. Name: customize calculation name or accept default calculation name 

4. Slices: select a slice type 

5. First Slice: Start slice for calculation 

6. Second Slice: End slice for calculation 

7. Tube Diameter: Diameter of the tube 

8. Color: Color used to display the curve 

9. Display: can be hidden or set with transparent level 

10. Click OK 

11. The curve calculation appears in the Calculations tab, as seen below. 

 
 

Changing the Inner and Outer Curve View Mode 
 

After building a virtual graft, right click on the virtual graft button   located in the 3D 

model panel. 
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. 

   

There are three view modes available: 
Mesh view: show polygons and longitudes 

Point view: show longitudes in dotted lines 

Fill view: regular view 

 

 

 
   Mesh View                               Point View                        Fill View 
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Chapter 4 - Creating a Virtual Graft 

VirtualGraft™ Method for Sizing Bifurcated Stent Grafts 

 
Preview offers three options for the VirtualGraft: the Generic, Custom Tube or the 
Manufacturer Specific. With any method, you select the proximal starting location for a graft 
and then enter graft sizes. The VirtualGraft appears within the lumen in the model and 
allows a simple, visual evaluation of the fit of the selected graft sizes. 
 
When using Preview to assess a patient's anatomy for potential stent graft repair, it is 
important to remember that several factors can impact the accuracy of the measurements 
made on the scan data. These include: 
 

 the quality of the scan data itself 
 the time that may have passed since the scan was taken 
 the stent graft being considered 
 the technique to be used in its deployment 

 
For example, it has been theorized that stiff guide wires can straighten both the aorta and 
the iliac arteries and that such straightening can shorten the overall length of the anatomy 
from the renal arteries to the internal iliac arteries by several millimeters. 
 
If this is true, and if a device with 'hooks' or other fixation mechanisms is used along such 
stiff guide wire and if the device is deployed rapidly such that the anatomy does not have 
time to return to normal shape before the attachment mechanisms lock it into place, then 
the graft may extend farther down the anatomy than anticipated based on pre-operative 
measurements or VirtualGraft calculations. 
 
Therefore, use caution when evaluating measurements made on pre-operative anatomy. Be 
sure to take into account both the type of device and deployment technique you plan to use. 
 
Begin by clicking the Virtual Graft tab at the top of the Main Preview Window. Preview will 
verify you are using oblique slice sets. If you are not, Preview will prompt you to switch and 
will do so automatically upon clicking OK. 
 

Determine the Start Location for the Graft 
 

To determine the start location for the graft, perform the following steps: 

 

Note: The default start slice will be set by the oblique slice of the distal renal mark if you 

have made one. 
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1. Use the slice slider to scroll through the slices to determine the start location for 

the graft. 

 

The drop slice will move through the model. 

  

2. Click the Grab Slice button. 

 

Preview will automatically enter the slice number. Alternatively, you can enter 

the slice number in the text field above the Grab Slice button. 

 

Building the VirtualGraft  
 

You may work with Manufacturer-Specific components, the Generic option, or custom 

tube to build a VirtualGraft. Before you start, review your calculations—vessel diameters 

and lengths—and the manufacturer’s recommended oversizing recommendations. 

Following the steps below, you will use the VirtualGraft feature to view your selected 

graft in the model. 

Create a Manufacturer-Specific VirtualGraft (MSVG) 
 

You can build a graft utilizing actual components provided to M2S by the manufacturers.  

 

Note: The example provided here is for a modular graft design with 

multiple components. 

 

1. Select New Graft. 

  

2. Select a manufacturer from the list by either clicking the circle to the right of 

the manufacturer’s name, or on the name itself. 
 

Some manufacturers are currently inactive and cannot be selected from the list. If 

the graft you would like to use is not available, select Generic and follow the 

instructions provided later in this section. 

  

3. Determine your graft design interface. 
 

At this point, you will be met with one of two different interfaces for designing 

your graft. If the Design Your [Manufacturer Name] Graft window comes up 

(pictured below), continue this tutorial. Some grafts will use an alternative 

interface which is described later in this section under Using the EZGraft Tool. 

This is the interface from which you can select the various components for your 

graft: 
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The Graft Design Window  

 

To return to the Preview Main Window without building a graft, select 

Cancel. 

 

4. Determine an insertion side. Choose either Left or Right. 

  

5. Select a Trunk-Ipsilateral Bifur Component from the options 

provided. 
 

Refer to the calculations listed under Standard Measurement Values. Only 

measurements saved utilizing the Type drop-down menu will appear in 

this area. You can add a Type to a calculation by editing it. Instruction on 

editing a calculation is provided in the section entitled Editing a 

Calculation. 

  

6. Select an Iliac Leg Component, if desired. 
 

To add an iliac leg component, click on the desired piece and drag and 
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release it into either the Contralateral or Ipsilateral folder in the 

Extensions window. 

 

Preview defaults to the manufacturer-recommended overlap. To change 

the overlap, highlight the piece in the Extensions window and either type 

in a new number in the text field and press Enter, or click the up and 

down arrows next to the overlap text field. 

 

Total length of components is automatically updated as components are 

selected from menu choices. 

 

Extension Cuffs 
 

Iliac and aortic extension cuffs are available within the Manufacturer-Specific Virtual 

Graft feature, if provided by the manufacturer. Preview defaults to the manufacturer-

recommended overlap and deactivates components that are incompatible with existing 

component scenarios. 

Iliac Extension Cuffs 
 

Follow these steps to insert an iliac extension cuff, if desired: 

 

1. Select the dimensions for the extension cuff. 

  

2. Click on the desired piece and drag and release it into the appropriate folder 

in the Extensions window. 
 

Some pieces may cause alerts to appear. These warnings are determined by the 

manufacturer in accordance with their Instructions for Use.  

 

To change the overlap, highlight the piece in the Extensions window and either 

type in a new number in the text field and press Enter, or click the up and down 

arrows next to the overlap text field. 

  

3. You may also delete an extension cuff. 
 

Highlight the appropriate extender component in the Extensions window and 

select Delete. Preview will remove the component from the Extensions window. 

Aortic Extension Cuffs 
 

To add an aortic extension cuff, click on the desired piece and drag and release it into the 

Aortic Neck Extensions folder in the Extensions window. To change the overlap, 

highlight the piece in the Extensions window and either type in a new number in the text 
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field and press Enter, or click the up and down arrows next to the overlap text field. To 

delete an aortic extension cuff, highlight the piece in the Extensions window and select 

Delete. 

 

For some manufacturers, Preview will allow the use of aortic extension cuffs in the iliac 

legs provided they are the last piece on that side. Only one cuff can be used on each side. 

 

Note: Some overlap values are fixed and cannot be changed` in accordance 

with the requirements specified by that device manufacturer. 

 

Instructions for Use  
 

The manufacturer-specific Instructions for Use can be accessed by clicking on the blue 

IFU link at the bottom of the window. The Instructions for Use will load onto your 

browser. 

 

View MSVG in Model 
 

After you have selected the components, it is important to view the scenario within the 

model. 

 

1. Select Build from the Design Your [Manufacturer Name] Graft window. 
 

Preview places the VirtualGraft within the model and returns to the standard 

interface. 

 

Preview automatically removes thrombus from the model, and turns bloodflow 

transparent for better visibility of the graft. The graft components and overlap 

zones are indicated with different colors. The trunk-ipsilateral bifur components 

are green, the extenders are blue and the overlaps (with oversizing) are yellow. 
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A Manufacturer-Specific VirtualGraft in the 3D model of an aneurysm  

 

The VirtualGraft scenario is listed within the Device window in the Virtual 

Graft tab. A separate folder appears for each graft scenario. Double-click 

the folder to view the components, or highlight the folder and click Edit. 

 

2. Rotate the model to view it from all sides and evaluate the graft 

placement within the aneurysm. 

  

3. Click the Anatomy tab and make bloodflow visible. Click the Virtual Graft 

tab and make the graft transparent by selecting the Transparent checkbox. 

This will aid in sealzone assessment. 

Multiple Graft Scenarios 
 

In the event you are exploring several VirtualGraft scenarios, you will have to follow 

these steps to view each VirtualGraft within the model. 



Chapter 4 - Creating a Virtual Graft 

121 DES-MAN-1-02 Rev. P 

 

1. Select the VirtualGraft you wish to place in the model from the Devices 

window.  
 

The selected graft is highlighted within a blue box. 

Modify a VirtualGraft 
 

Edit Graft Appearance 

 

If you would like to change the VirtualGraft appearance, click the VG button on the 

Model View Bar. This works for both Manufacturer-Specific and Generic grafts.   

 

To change or remove a VirtualGraft scenario, follow these steps: 

 

1. Highlight the VirtualGraft in the Device window. 

  

2. To adjust the components, select Edit or double-click the VirtualGraft listing. 
 

The Graft specification window appears. Select the components you wish to 

change or adjust the numbers and click Build. The revised scenario is 

automatically updated within the model and the Device window. 

The EZGraft Tool 
 

Some manufacturer’s devices will be displayed using a different interface. A picture of 

this interface is shown below. 
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An Example of a Design Interface 

 

Working with the EZGraft 
 

A graft will automatically appear in the Preview model using the minimum size 

components. You will use the EZ-Graft designer to edit the components to fit the 

anatomy. 

 

The EZ-Graft designer consists of three different part selection tools - Insertion, Parts and 

Twisteroo. Each tool edits a different component of your VirtualGraft. 

 

First, select an insertion side for the bifurcated device in your graft scenario - either left 

(left iliac artery) or right (right iliac artery). By default, the insertion side is set to the 

right.  To view your changes in the model, click Build. 

 

Editing a Graft 
 

Change the Diameter and Length 

 

To change the diameter of a device, use the buttons to the left and right of the part 

number. If the part number does not change, then the manufacturer does not provide a 

device with the requested dimensions. To view your changes in the model, click Build. 
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To change the length of a device, use the buttons above and below the part number. To 

view your changes in the model, click Build. 

 

Hold your mouse over any button to see a description of what the tool will do. 

 

Adding Extensions 
 

Certain grafts have the ability to add supplementary extensions. If this option is available 

for left iliac or right iliac extenders, click on the checkbox labeled “enable” to add the 

extender to your graft. If more extenders are available for either the aorta, right iliac, or 

left iliac, a button with a right arrow will be available to the right of the device. Click the 

button to view the new extension, and as before, click on the “enable” checkbox to enable 

the new device. To view your changes in the model, click Build. 

 

Changing the Point of Reference 
 

Certain grafts have the ability to define their location in space relative to the point of 

bifurcation, as opposed to the point at which the graft begins. If this option is available 

there will be a combo box to the right of the “Insertion Side” option. The options in the 

combo box will be “Bifurcation Slice” and “Start Slice”. To view your changes in the 

model, click Build. 

Changing the Overlap 
 

The Left and Right Iliac devices have an 'Overlap' box near the part number. Use the 

scroll buttons or type in a number to change this value and click Build. 

Twisteroo™ 
 

M2S' Twisteroo feature allows you to define the contralateral limb orientation of your 

graft to simulate your expected graft path. 

 

The Twisteroo is labeled 'Native Iliac Rotation' in blue. Two circles represent the 

contralateral and ipsilateral limbs. Click and drag either of the limbs to rotate them. 

Native Iliac Rotation 
 

The native iliac rotation of the anatomy is calculated by comparing the location of the left 

and right iliac in the axial plane and calculating their rotation away from patient L/R. 

This angle is represented by the green line through the middle of the Twisteroo tool. 
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Some manufacturer devices are not intended to be fully twisted. If this is the case, 

Preview will prevent additional rotation. 

 

Ordering a Manufacturer Specific Virtual Graft 
 

Once you have created a successful VirtualGraft, you can create a parts list for the 

selected components that may guide you in placing an order with the device 

manufacturer. Follow these steps: 

 

Note: If you would like to quit the process at any time, click the "Cancel" button.  

 

1. Highlight the appropriate VirtualGraft (indicated with a blue box) in the 

Device window under the VirtualGraft tab. 

  

2. Click Order Form. 
 

The Product Listing window appears. 

  

3. Review components.  
 

Preview automatically indicates component quantities in the Product Listing 

window. You may increase quantities, and/or select additional components to 

order. 

  

4. Click Continue once you are satisfied with selections and quantities. 
 

An alert may appear to verify you are satisfied with accessory component 

quantities. Select No to return to previous screen and change introducer sheath 

quantities or select OK to continue. 

  

5. If applicable, describe your project in the text fields provided in the Describe 

Your Project window. 
  

6. Click Continue.  

  

7. Confirm your selections. 
 

A summary window appears. It provides the manufacturer and brand name of the 

stent graft, a list of VirtualGraft components, and indicates Twisteroo, start slice 

and insertion side. 

  

8. Print to local printer by selecting Print. 
 

The information will print as it appears on the summary window. 
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Click Cancel to quit the process and return to the Preview Main Window. 

Create a Custom Tube Graft  
 

If you would like to size a tube, or series of tubes along the anatomy centerlines, choose 

the custom tube. 

 

1. The custom Graft Builder window appears. 

  

2. Determine the start location for the Custom Tube Graft. 
 

Determine the start slice for the graft. For more information, see the section 

entitled Determine the Start Location for The Graft  

  

3. Select insertion side. 

  

4. Build a Simple Graft 

  

 Use the slider above the green representation of the tube to change the 

diameter of the tube. You can also type the diameter into the box, or click 

and drag the green representation of the tube. 

  

 Type the desired length of the graft into the box labeled ‘Length’. 

  

5. Build a Complex Graft 

  

 Follow step 4 above, and then click on the ‘Complex’ button. This option 

will allow you to build tapered grafts.  

  

 A tapered graft will have a different proximal and distal diameter. Use the 

slider above the green tube representation to change the proximal diameter 

and the slider below to edit the distal diameter. 

  

 To change the location of the taper, click and drag the green tube 

representation. The numbers to the left indicate how much of the tube will 

be at each diameter. 

  

6. Add additional pieces  

  

 You can add up to 2 additional pieces to each tube project.  

  

 To enable another device, click the checkbox next to the representation of 

the tube. 
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 Size the tube as shown above. 

  

 Edit the overlap into the proximal tube using the overlap input. 

 

Note: Preview represents overlap with oversizing anytime a tube that is 

distal to another tube is of a larger diameter. Preview indicates this as a 

yellow area on the side of the tube. This is an indication that there is some 

level of seal between the devices, however it does not take into account 

any manufacturer’s oversizing recommendations. 

  

 For surgery planning using discontinuous tubes, create more than one 

Custom Tube Project. 

  

7. Select Build to view the Custom Tube Graft within the model. 
 

Preview automatically removes thrombus from the model, and turns bloodflow 

transparent for better visibility of the graft. 

Create a Generic VirtualGraft 
 

In the event you need to create a graft with your own dimensions, utilize the Generic 

VirtualGraft feature. Follow these steps: 

 

1. Determine the start location for the VirtualGraft. 
 

See the section entitled Determine the Start Location for the Graft.  

  

2. Decide whether to start the generic graft legs from trunk or start slice. 
 

The Preview default option is to start the graft legs from the end of the trunk. To 

select the option to start the graft legs from the start slice, select Edit Your 

Preferences... from under the Help menu and click the Virtual Graft tab. Select 

the appropriate radio button and click OK. 

 

Note: Preview will default to the chosen option in subsequent sessions. 

  

3. Select Build Graft. 

  

4. Select Generic from the Select Manufacturer window. 
 

The Custom Graft Builder window appears. Measurements you made and saved 

using the Type drop-down menu will appear under Standard Measurement 

Values. You can add a Type to the calculations by editing the calculation. 

Instruction on editing calculations is provided in the section entitled Editing a 

Calculation.  
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The Custom Graft Builder Window 

 

5. Select the Insertion side.  

  

6. Enter the correct information for the graft you have selected in the text 

fields. 

  

7. Select rotation and orientation for graft deployment. 

  

8. Select Build to view the VirtualGraft within the model. 
 

Preview automatically removes the thrombus from the model, and turns blood 

flow transparent for better visibility of the graft.  
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A Generic Virtual Graft in the 3D model of an aneurysm 

 

The Generic Graft scenario is listed within the Device window in the 

Virtual Graft tab. A separate folder appears for each graft scenario. 

 

Double-click the folder to view the components. Extender components are 

not available within the Generic VirtualGraft feature.  

 

Print the Generic Graft 
 

1. Highlight the appropriate Generic Graft in the Devices window under the 

VirtualGraft tab. 

  

2. Click Order Form. 
 

The Confirm Your Selections window appears. It lists graft components, 

Twisteroo, start slice and insertion side.  
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3. Select Print to print to a local printer or Cancel to quit the process and 

return to the Preview Main Window. 

 

The information will print as it appears in the summary window. The Create PDF option 

is invalid with the Generic VirtualGraft at this time. 

 

Evaluate the Sealzone Diameters 
 

In areas of effective sealzone, the green VirtualGraft appears outside the model. In areas 

where the green VirtualGraft is not visible, the VirtualGraft is smaller than the vessel. 

 

1. If the VirtualGraft appears to be undersized, double-click the calculation in 

the Calculations list and select a different modular diameter. 

  

2. If the VirtualGraft appears to be oversized, perform a cross-section analysis 

on the Aorta-Right Iliac or Aorta-Left Iliac slices as shown in the next steps. 

Analyze Sealzone Diameters in Slices 
 

To perform a cross-sectional analysis by evaluating the sealzone diameters in the slices, 

perform the following steps: 

 

1. Scroll to slices in the area of the sealzone. 

  

2. Add a mark in the center of the bloodflow path. 

  

3. Double-click the mark to open the Edit Mark dialog box. 

  

4. Set the mark diameter to the diameter of the graft you are testing. 

  

5. Click Save Defaults, then click OK. 

  

6. Scroll through the area of the sealzone and add marks to see the degree of 

oversizing. 

  

7. After determining the degree of oversizing, delete the marks. 

Evaluate the Sealzone Lengths 
 

To evaluate whether your VirtualGraft creates adequate sealzone lengths, perform the 

following steps: 

 

1. Measure the length of the proximal neck sealzone. 
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Use the Jump Slice tool to find the slice where the vessel begins to be larger than 

the VirtualGraft. Perform a centerline calculation to measure the length from the 

top of the graft. Select “Proximal Neck Sealzone” from the Type drop-down 

menu.  

  

2. Measure the length of the right-iliac sealzone. 
 

Select Aorta-Right Iliac slices. Use the Jump Slice tool to find the slice where 

the vessel begins to be larger than the VirtualGraft. Select the Cur Slice checkbox 

to show the slice location in the model. Perform a centerline calculation to 

measure the length from the distal end of the graft. Select “Right Iliac Sealzone” 

from the Type drop-down menu. 

  

3. Measure the length of the left-iliac sealzone. 
 

Select Aorta-Left Iliac slices. Use the Jump Slice tool to find the slice where the 

vessel begins to be larger than the VirtualGraft. Select the Cur Slice checkbox to 

show the slice location in the model. Perform a centerline calculation to measure 

the length from the distal end of the graft. Select “Left Iliac Sealzone” from the 

Type drop-down menu.  
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Chapter 5 - External Applications of  
Preview 

Printing a Preview Window 

 
Printed output can be useful for records, discussion with the members of your medical team, 
and for consultation with your patient. You can print any image that appears on your screen. 
You can also choose slices and model views to include in your plan report, which you can 
then print. See the section entitled Creating a Report.  
 

Adjusting Model Display 
 

Prior to printing the Preview window, you may want to adjust the image Lighting or 

Background Color. Both options are available from the Model menu at the top of the 

screen. 

 

Printing a Window 
 

To print the Main Preview Window — which includes the Slice area, the Model area, and 

the Lists area — or any individual Slice window, perform the following steps: 

 

1. Make the window you want to print the active window. 

  

2. From the window’s File menu, select Page Setup. 
 

In the Page Setup dialog box, select page size, margins, and orientation, and click 

OK. 

  

3. From the window’s File menu, select Print. 
 

In the Print dialog box, select the printer and number of copies. 

  

4. Click OK when you are ready to print. 

Printing Windows in a JPEG File 
 

An alternative way to print window images is to save them to a JPEG file and then print 

the file. You can attach a JPEG file to an e-mail message or post it on a website. To print 

a JPEG file of a window, perform the following steps:  
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1. Make the window you want to print the active window. 

  

2. From the window’s File menu, select Save Image. 

  

3. Select an image quality. 
 

In the Save Image Options dialog box, select the image quality for the JPEG file. 

Note that the Maximum option creates a large file that takes more disk space and 

may take longer to transmit online. However, you should use the Maximum 

option when possible to achieve the best image quality. 

  

4. If you are saving an image from a slice window, select the image to save. 
 

When you save a slice window image, you can save the entire window or the slice 

image only. Note these differences in the Image to Save options: 

  

 Save Current Window saves the image with marks, mark names, etc., 

just as the window image appears onscreen. 

  

 Save Full Slice without Window saves the full slice image at 100% 

zoom, not cropped by the window. Once you select this option, you can 

choose to show or hide marks by selecting or deselecting the Include 

Marks checkbox. 

  

5. Click OK. 

  

6. Select the destination drive and folder.  
 

In the Save dialog box, click the Save In: drop-down menu to select the drive you 

want to save the file to. To save the file to a folder, double-click the folder’s 

name. (For instructions on creating a new folder, see the section entitled Saving 

Your Work.) 

  

7. Name the file. 
 

In the File Name field, type a descriptive name of the file. Leave the default 

extension — .jpg — as the file name’s extension. 

  

8. Click Save. 
 

The window images are saved to the designated directory, folder, and file. 

  

9. Print the image. 
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Use Windows Explorer to open the file. From your Image Viewer’s File menu, 

select Print. 

Saving and Printing Windows In a Word Processing File 
 

Another way to save and print a window is to save it to a word-processing file. To do so, 

perform the following steps: 

 

1. Make the window you want to print the active window. 

  

2. Press and hold the Alt key and then press the Print Scrn key. 
 

The Print Scrn key is usually to the right of the 12 function keys on the keyboard. 

Pressing Alt with Print Scrn causes the computer to capture only the active 

window. 

  

3. Open any word-processing program. 
 

From the Start button, select Programs. From the Programs submenu, select a 

word-processing program such as Microsoft Word. 

  

4. In the document that opens, paste the image. 
 

Press Ctrl-V, or select Paste from the Edit menu. 

  

5. Adjust the image size. 
 

Drag the handle in any of the image’s corners to reduce or enlarge its size 

proportionally. Do not drag a handle on the side of the image or it will distort the 

image’s proportions. 

  

6. Print the image. 
 

From the word processor’s File menu, select Print. 

  

7. If desired, save the word-processing document. 
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Creating a Report 

 
Preview’s report feature creates a report of your patient plan’s calculations, mark diameters, 
notes, bookmarked slices, and model images. The report is useful documentation that you 
can add to your patient’s medical record. Usually, you will create reports in an HTML 
format. The HTML format is ideal for viewing a report on your Internet browser, printing, 
e-mailing to colleagues, or posting on an Internet site. 
 

Creating a Report 
 

When you have completed a patient document plan, create a report using the following 

steps: 

 

1. Save the document plan. 

  

2. From the File menu, select Create Report. 

  

3. Select the report style. 
 

In the Report Options dialog box, select HTML, text, or spreadsheet. Note the 

following about the various report styles: 

  

 HTML (.html - Web Browser) - HTML is the usual format for reports. 

Select HTML if you want your report to include slice or model images. 

  

 Text (.wri - Write/WordPad) - Although you can view a report in text 

style in Microsoft Word, the report may have extraneous symbols in it. 

The report is best viewed in WordPad (WordPad’s files have the .wri 

extension). 

  

 Spreadsheet (.txt - Tab-Delimited) - After saving a report in spreadsheet 

format, open it in Microsoft Excel and follow Excel’s prompts to format it. 

Choose “Delimited” as the file type, then select “Tabs” as the delimiter. 

  

4. Select items to include in the report. 
 

Select the checkboxes of all items you want to include in the report. For patient 

confidentiality, you may choose to omit the patient’s name from the report. 

  

5. Click Open to create the report and open it in the default application. 
 

Preview will save the report in your Reports directory automatically so that you 
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can open it later.  

  

6. Alternatively, you can elect to simply save the report.  
 

To do this, click Save. 

  

7. In the Save dialog box, select the destination drive and folder. 
 

(For instructions on creating folders and saving files in Preview’s Save dialog 

box, see the section entitled Saving Your Work.)  

  

8. Click Save. 

Viewing a Report 
 

After you save the report, Preview asks if you want to view the report immediately. Do 

one of the following: 

 

 Click Yes to view the report immediately. 

  

 Click No to view the report later (using an Internet browser or another 

program). 

Opening an HTML Report in an Internet Browser 
 

You can open an HTML Preview report in an Internet browser such as Internet Explorer 

or Netscape, or in a version of Microsoft Word that has an HTML editor. You can print 

the report from any of these programs. 

 

To open a report in a browser, perform the following steps: 

 

1. Double-click the browser icon. 

  

2. If you are not connected to your Internet server, you can choose to work 

offline. 

  

3. From the browser’s menu bar, select Open from the File menu. 

  

4. Browse to find your report file. 
 

In the Open dialog box, select Browse. In the second Open dialog box, select 

HTML Files from the "Files of Type:" drop-down list. Select the drive and 

folder where you stored the report and click Open. 
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5. Open the report. 

  

6. If desired, print the report. 
 

From the File menu, select Print. 

Using Windows Explorer to Open a Report 
 

You can also open your Preview report directly from Windows Explorer. Perform the 

following steps: 

 

1. Right-click on the Start menu and choose Explore. 

  

2. Select the report file from the correct destination drive and folder. 

  

3. Double-click on the report file name. 
 

The report opens. 

  

4. If desired, print the report. 
 

From the File menu, select Print. 

Adding Images to a Report 
 

After creating a report, you may decide you want to add other slice images to the report. 

The best approach is to add the appropriate bookmarks or views to the document plan and 

create a new report. If, however, you are comfortable using an HTML editor, you can 

save the images by using the Save Image command or pressing Alt-Print Scrn, then 

adding the images to the report in a program such as Netscape Composer. 

 

E-mailing a Preview Report 
 

You may want to share a report’s findings with a colleague by e-mail. When e-mailing a 

report, you must send the entire folder containing the HTML file and all associated 

images. For convenience, you probably will want to “archive” the report folder using a 

zip program such as WinZip. The files must be zipped into a single zip file before 

sending. 

 

1. Open a zip program.  

  

2. Select New to create a new zip file. 
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3. Browse to find the folder with your plan and its images. 

  

4. Name the zip file you are going to create. 

  

5. Add the HTML file and all the image files to the zip file. 
  

6. From your e-mail program, attach the zip file to your e-mail message and 

send. 
 

The person receiving your e-mail will need to unzip the file and open the report in 

an Internet browser. 

 

Note: You can also use some web browsers to save a web archive, which will 

store the report text and images together in one file. For example, in Internet 

Explorer, select Save As, then select the format Web Archive, single file (or a 

similar choice). It may be necessary to view the web archive in the same browser 

in which it was created.  
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Using Preview Images in Presentations 

 
You may want to capture Preview images for inclusion in slide presentations. After saving an 
image to a JPEG file, you can modify it in a graphics application such as PaintShop Pro or 
Photoshop and then import it into a presentation application such as PowerPoint. Below are 
the basic steps for getting Preview images into a PowerPoint presentation. 
 

Saving the Image  

 
1. Save the image. 

 

Follow steps 1-8 in the section entitled Printing Windows in a JPEG File; or with 

the desired window onscreen, press Alt-Print Scrn. 

  

2. Import the image into PaintShop Pro or a similar graphics application. 

 

From the graphics program’s File menu, select Open or Import.  

  

3. Use the crop tool to remove unwanted parts of the image. 

  

4. If necessary, brighten the image of the model by adjusting the brightness 

levels. 

 

Slice images reproduce accurately. Model images, however, usually improve 

when you brighten them: 

  

 In Photoshop, press Ctrl-L to see a graph of the image’s input levels. 

With the mouse, drag the far-right triangle under the graph to the left to 

brighten the image, and click OK. 

  

 In PaintShop Pro, from the Colors menu, select Adjust, then select 

Brightness/Contrast. Increase the brightness by approximately 20%-

30%, and click OK. 

Inserting Images into PowerPoint 

 
To insert graphic images into PowerPoint, perform the following steps: 

 

1. In the New Slide dialog box, pick a presentation format. 

  

2. Add a title to the slide. 
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3. From the Format menu, select Slide Color Scheme. 

 

The Slide Color Scheme allows you to pick both the color scheme and slide 

format. 

  

4. From the choices presented, select the desired color scheme and format. 

  

5. From the Insert menu, select New Slide to create a new slide. 

  

6. Click the image frame within the slide to make it active. 

  

7. From the Insert menu, select Picture, then select From File. 

  

8. Browse to find your saved image. 

  

9. In PowerPoint, click the Insert button. 

 

PowerPoint inserts the image into the slide. 

  

10. Adjust the image. 

 

Click and drag to position the image. To resize the image, click a corner and drag 

it to the desired size. 

  

11. If necessary, change the background appearance. 

 

From the Format menu, select Background and make necessary adjustments. 

  

Most images from Microsoft products can be imported into PowerPoint. These images 

include tables, Excel graphs, and Excel pie charts. 
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Chapter 6 - M2S Customer Support 

M2S Preview Customer Support 

 
M2S provides you with free technical support via phone, fax, and e-mail. Skilled technicians 
are ready to help you if you experience problems with our software or data, or if you simply 
have a question about ordering, installing, or operating the M2S Preview product. 
 
Before you contact us, we suggest you follow these steps: 
 

1. Check the relevant sections in this User’s Guide about the Preview tools you 
are using. Use the Index to locate additional references. 
  

2. Consult your technical resource person or computer dealer for problems 
related to the hardware or operating system. 
  

3. Check that you meet the minimum hardware and software requirements 
described in the section entitled System Requirements. 
  

4. Refer to the M2S website at http://www.m2s.com/company/contact-us. 



Chapter 6 - M2S Customer Support 

141 DES-MAN-1-02 Rev. P 

Contact Information 

 
You can access M2S Technical Support by phone, fax, or e-mail. 
 

Telephone Support 
 

Telephone Number: 1.603.298.5509  

Hours: 8:00 am to 5:00 pm EST, Monday through Friday 

 

When you are ready to call us, please do the following: 

  

1. List the Preview tools you used and the steps you took when the problem 

occurred. 

  

2. If an error message appeared, write down the exact text of the message. If 

possible, print the screen where the error occurred. (From the File menu, select 

Print.) 

  

3. Have your computer turned on and be prepared to reproduce the problem or take 

the steps suggested by the M2S technician. 

FAX Support 
 

FAX Number: 1.603.298.5055 

  

 If possible, please Fax a screen print where the error occurred. (From the 

File menu, select Print.) 

 

After studying the information you faxed, a technical support analyst will call you to help 

you solve the problem. 

Support via the Internet 
 

Internet address: http://www.m2s.com/company/contact-us 

 

Navigate to the above Internet address, where you will find the M2S Technical Support 

Request Form, and do the following: 

 

1. Fill in the form’s fields. 

  

2. In the Problem text box, type a description of the problem, including: 
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 The Preview tools you used and the steps you took when the problem 

occurred. 

  

 The exact text of any error messages that appeared. 

  

 Your computer model and Preview version you are using. 

  

3. Click the Submit button below the Problem text box to send the form to 

M2S. 

 

A technical support analyst will examine the information you submit, then call or e-mail 

you with instructions that will help you solve the problem. 

 

E-Mail Support 
 

E-mail Address: preview-support@m2s.com 

 

In lieu of using the M2S website, you can simply report a problem via e-mail. Please 

include in your e-mail message: 

 

 A complete description of the problem, as noted above. 

  

 Your computer model and the Preview version you are using. 

  

 Your name and telephone number. 

  

Note: If Preview detects an error, you will see a window as you 

exit Preview that contains instructions on how to e-mail M2S. 

 

A technical support analyst will call or e-mail you to 

help you solve the problem. 
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Appendix 

Menus, Tabs, and Tools 

 
This section reviews the functions available via the Preview menu bar, describes how to use 
the row of tabs below the menu bar, and summarizes the available shortcut keys and tools. 
 
You will notice as you become familiar with Preview that many of the commands available 
in the menu bar are also available within the tabs below the menu bar and those below the 
Slice Area. This user guide usually points you first to the non-menu commands, which in 
most cases are easier to use. Using shortcut keys — pressing combinations of keys — offers 
perhaps the most efficient way to carry out some Preview functions. 
 
Let’s first take a look at Preview’s menu commands. 
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Menu Conventions 

 
M2S Preview uses many of the menu conventions common to Windows applications. 
 
Ellipses 
Some menu choices are followed by an ellipsis (Save As..., for example). When you select 
this type of menu item, a dialog box appears providing additional information and requiring 
further instruction from you. 
 
Right-Pointing Arrow 
Some menu choices are followed by a right-pointing arrow to indicate that you need to make 
a selection from a submenu that appears to the right of the menu. 
 
Dimmed Menu Selection 
A “dimmed” menu selection is not available. When the menu action becomes available, the 
menu item appears in normal type. 
 
Bulleted Selections 

A bullet in a circle preceding a menu item such as Marks Filled indicates that the option 

is currently active. After you select the item, Preview turns off the alternate option (such 

as Marks Hollow). 

 

Checkboxes 

A check mark next to a menu command indicates that the command is currently active. In 

the Marks menu, for example, check marks appear next to settings such as Display Mark 

Names that are turned “on.” 

 

Keyboard Shortcuts 

Keyboard alternatives (“shortcuts”) for menu commands, when available, appear next to 

the menu command names. Keyboard shortcuts employ the Windows Control (Ctrl) key 

in combination with another key. For example, Ctrl-D is the keyboard shortcut for the 

Drop Slice Into Model command. 

 

You will find a summary of keyboard shortcuts later in the appendix. . 
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File Menu 

 
The File menu is a common feature in Windows applications. From the File menu, you can 
open, close, and save a plan document, print, create a report, and exit the Preview program. 
 

New (Ctrl-N)  

 
When you choose the New command, Preview creates a new, empty plan document file 

in which you can create and save marks, calculations, drop slices, and custom model 

views. 

 

If you already have a plan document open, Preview prompts you to save or discard any 

changes, and Preview closes the current plan document before creating a new one. 

Open... (Ctrl-O) 

 
Use the Open command to open a previously saved plan document file for the patient 

data that is currently loaded. 

 

If you already have a plan document open, Preview prompts you to save or discard any 

changes, and Preview closes the current plan document before opening a new one. 

Save (Ctrl-S) 

 
Use this command to save marks, custom views, drop slices, and calculations in a plan 

document file. If you are using a newly created document and you select the Save 

command, Preview prompts you to assign a file name and folder. 

Save As... 

 
Use this command to save and name a new plan, or to save the current plan under a new 

name. In the Save As dialog box, assign a name and folder to the plan document file. 

Revert 

 
This command discards all unsaved changes to a plan document, and reverts to the file to 

the last saved version. 

Create Report... 



Preview User's Manual 

146 DES-MAN-1-02 Rev. P 

 
Use the Create Report command to create a report of all your calculations, bookmarked 

slices, model pictures, and notes — the entire plan document or portions you select to 

include in the reports. Preview optionally creates the report in an HTML format that you 

can view on your Internet browser, print, e-mail to a colleague, or post on an Internet site. 

 

Save Image... 

 
Use the Save Image command to save a window to a JPEG file, which you can then 

attach to an e-mail or post on an Internet site. 

Page Setup... 

 
Select the Page Setup command to choose a page’s size, orientation and margins before 

printing a Preview window. 

Print (Ctrl-P)...  

 
Use the Print command to print a hard copy of a Preview window. 

Exit (Ctrl-X) 

 
The Exit command closes the Preview program. If you have unsaved changes in an open 

plan document file, you are prompted to either save or discard them. You can also cancel 

the Exit command, or go to the M2S website to fill out a feedback form. 
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Slices Menu 

 
From the Slices menu, you can access views of slices from the original patient scan. Based 
on the original axial scan data, Preview also gives you access to all multiplanar 
reconstructions — coronal and sagittal. For vascular patient applications, Preview reformats 
the scan data to render Aorta, Aorta-Right Iliac, and Aorta-Left Iliac slices, which are 
perpendicular to the flow channel.  
 
Also see Viewing Coronal, Sagittal, and Oblique Slices in the section entitled Working with 
Slices for details on other ways to control the slice windows. 
 

Set Slice Area 

 
Highlighting Set Slice Area opens a submenu of options listing the scan types available. 

After highlighting Set Slice Area, select the desired slice on the submenu. The new slice 

view opens in the Slice area at the bottom left of the screen. 

 

Axial — Selecting this option opens Axial slices, if they are not already selected. The 

Axial slices display scan data in the top-to-bottom sequence. 

 

Coronal — Selecting this option opens Coronal slices, if they are not already selected. 

The Coronal slices display scan data in a front-to-back slice sequence. 

 

Sagittal — Selecting this option opens the Sagittal slices, if they are not already selected. 

The Sagittal slices display scan data in a right-to-left slice sequence. 

 

Aorta, Aorta-Left Iliac and Aorta-Right Iliac — These options open the Aorta and 

Aorta-Iliac slices, and are available only for vascular applications. These slices are 

reconstructed from original scan data and are created to provide a sequence of slices that 

are perpendicular to the center line of the flow channel. 

 

Note: These slices are also referred to as multiplanar reformats 

(MPRs) or orthogonal slices. 

Open New Slice Window 

 
Highlight Open New Slice Window to display a submenu of slice 

views. From the submenu, select the desired slice. A new window 

with the selected slice type opens on the right side of the screen. 

 

You can have several slice views open at once. You can reduce the 

size of the Main Preview Window by dragging its right-bottom 
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corner up and to the left. Click Slices again, highlight Open New 

Slice Window, and select another slice you want to open. Adjust the 

size of the second window to allow you to see both slice views and 

the model. 

Show Slices Info 

 
Select the Show Slices Info command to open the Scan Information window. The Scan 

Information window contains details from the original digital slice data about the scan, 

the scan equipment, and various settings and measurements that apply to the scan data 

with which you are working. 

Next Slice (Ctrl-] ) 

 
Use the Next Slice command to go to the next slice in the sequence. A more 

convenient way to advance to the next slice is to simply press the right-arrow key 

on the keyboard, or to click anywhere to the right of the handle on the slider 

beneath the slice image. 

Previous Slice (Ctrl-[ ) 

 
Use the Previous Slice command to move to the previous slice in the 

sequence. For example, if you are viewing slice 43, the Previous 

Slice command displays slice 42 in the active window. A more 

convenient way to move to the previous slice is to press the left-

arrow key on the keyboard, or to click anywhere to the left of the 

handle on the slider beneath the slice image. 

Go to Slice #...(Ctrl-G) 

 
Use the Go to Slice # command to display a specific slice number in the active Slice 

window or to move a specific distance through the slices. In the Go to Slice # dialog box, 

type the target slice number in the New Slice # field. If you do not know the slice number 

you want to move to, type the number of millimeters to move along the path of the scan 

in the Move By Distance (mm) field and select the Direction to Move. 

Zoom In 

 
The Zoom In command doubles the size of the slice image in the active window and is 

useful for viewing a slice in enlarged detail. You can also enlarge the slice image by 
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using the Zoom tool in the Tool Palette, by clicking the Zoom In button below the slice 

image in the Slice Controls tab, or by right-clicking the mouse on the slice image. 

 

If the image is too big to completely fit on your display, use the Pan tool or the sliders 

beneath and to the right of the slice image to reveal hidden parts of the slice. 

Zoom Out 

 
The Zoom Out command reduces the size of the slice image by half. You can Zoom Out 

slices to free up space on the screen when you want to view several slice windows 

simultaneously. Other ways to zoom out are to use the Zoom tool in the Tool Palette 

while holding down the Shift key, click the Zoom Out button below the slice image or 

right-click on the slice image while holding down the Shift key. 

Drop Slice Into Model (Ctrl-D) 

 
Use the Drop Slice Into Model command to place the slice image from the currently 

active window into its corresponding position in the 3D model. The drop slice appears as 

an object in the Drop Slices list. To remove the slice from the model, select the slice 

name from the list and click the Delete button. 

Wire Drop Slice Into Model 

 
The Wire Drop Slice Into Model command is the same as the Drop Slice Into Model 

command, except that the slice appears as a wire frame. This allows easier viewing of the 

model. To remove the slice from the model, open the Drop Slices list, select the slice 

name and click the Delete button. 

Current Slice In Model (Ctrl-E) 

 
The Current Slice in Model command inserts the current slice image from the currently 

active window into the 3D model. As you move to a new slice in the Slice area, the slice 

straddling the 3D model changes to show the new slice and its position. Use this 

command to find the slices you want to “drop.” 

 

If the Current Slice in Model checkbox is selected, the current slice is “on.” To remove 

the current slice from the model, uncheck the Current Slice in Model checkbox, press 

Ctrl-E, or highlight the slice in the Drop Slices list and click Delete. 

Wire Current Slice Into Model 
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This command inserts a “wire” plane in the model at the location of the current slice. The 

wire slice provides the clearest view on the model of the slice’s exact location. To 

remove the wire slice, uncheck the checkbox in the Slices menu, or highlight the slice in 

the Drop Slices list and click Delete. 

Transparency in Drop Slices 

 
This command renders all dropped slices and current slices partially transparent. Use this 

command for better visibility of portions of the model that might be obstructed by the 

drop slice. A check mark indicates that the transparency format is enabled for drop slices. 

Set Drop Slice Trans...(Ctrl-T) 

 
Use this command to adjust the level of transparency in the drop slice. In the transparent 

format, the darker parts of a slice image are removed (or made transparent) from the Drop 

Slice image in the 3D model, allowing you to see through these areas. Transparency 

refers to removing the darker regions, not to an overall semi-transparent format. 

 

The box that defines the transparency range may be set anywhere between 0 (completely 

opaque) to 255 (maximum transparency). Entering lower numbers in the Drop Slice 

Transparency Level # dialog box removes the darkest areas of the slice; entering higher 

numbers removes most of the slice image, including the bright, white areas. Any pixel 

value in a drop slice lower than the transparency value will be transparent in the model 

view. 

 

The transparency level corresponds to 8-bit pixel values and not to Hounsfield units. In 

the 12-bit-resolution mode, different Window/Level settings will change the cutoff level 

set with Set Drop Slice Transparency. 
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Marks Menu 

 
Using commands from the Marks menu, you can specify how marks will appear in Model 
and Slice images. You can also jump the slices to the location of a specified mark. 

Show Marks List 

 
This command displays the list of marks in the current plan in the Lists area at the top-

left of the Main Preview Window. Double-click a mark name to access the Edit Mark 

dialog box, where you can name a mark, change its appearance, jump slices in open 

windows to the mark, or delete it. Right-clicking a mark name in the Marks list will also 

give you the options to edit, delete or jump slices to that mark. 

Jump Slices to Mark (Ctrl-J) 

 
Use this command to update (jump) all slice windows to the slice with the currently 

selected mark. You can also jump to a mark by highlighting the target mark in the Marks 

list and then clicking the Jump button below the Marks list. 

Auto Size (Ctrl-M) 

 
Use this command, on oblique slices (Aorta, Aorta-Right Iliac, Aorta-Left Iliac), to resize 

a mark to either the full vessel diameter or the lumen diameter. 

Display Marks 

 
Select the Display Marks checkbox to display the marks in all open slice and model 

images. Uncheck the Display Marks checkbox to hide the marks from view in all open 

windows. Turning off Display Marks does not delete the marks from the plan 

 

All Display commands are also available by clicking the Display button below the Marks 

list. 

Display Mark Names 

 
Select the Display Mark Names checkbox to display the mark names in all open slice 

and model images. Uncheck the Display Mark Names checkbox to hide the mark 

names. 

Display Mark Diameters 
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Select the Display Mark Diameters checkbox to display the diameter of each mark in all 

open slice and model images.  

Marks Filled 

 
Select this option to assign a solid-color attribute to all marks in slice images. 

Marks Hollow 

 
Select this option to assign a hollow drawing attribute to all marks in slice images. 
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Calculations Menu 

 
Open the Calculations menu to access Preview’s calculations features. You can also access 
these features by clicking the Calculations tab below the menu bar. 

Show Calculations List 

 
Select Show Calculations List to show the Calculations list in the top-left corner of the 

Main Preview Window. The Calculations list displays all of the current plan’s distance, 

volume, angle, multiline, and centerline calculations. 

 

To edit the properties of an existing calculation, double-click the calculation in the 

Calculations list to open its corresponding Calculation dialog box, and make your 

changes. 

 

To delete a calculation, select it in the Calculations list, then click the Delete button 

below the window, or press the Delete key or Backspace on the keyboard. 

 

Alternatively, right-click on a calculation in the Calculations list and select one of the 

options to edit or delete it. 

Display Calculations 

 
Select the Display Calculations checkbox to display the lines and tubes that represent 

any measured distances, angles, centerlines, and volumes. Uncheck the Display 

Calculations checkbox to hide your plan’s calculations. The calculation graphics appear 

in the model, and also in slices if the calculation’s marks are on the same slice. 

Display Calculation Names 

 
Select the Display Calculation Names checkbox to display the names of your plan’s 

calculations in the Slice area and/or window. By default, Preview assigns the names 

"Calc 1," "Calc 2," and so on to calculations. You can rename a calculation by double-

clicking it and typing a new name in the Edit Calculation dialog box. 

Display Calculation Results 

 
Select the Display Calculation Results checkbox to display your calculation's numerical 

results on the slice image in the Slice area and/or window. 
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Show All 

 
Un-select the “Show All” check box, under the Calculations tab to display, in the 3D 

model, only the calculations that have been selected. If the Calculation visibility icon 

below the 3D model is set to transparent, then the “Show All” check box will be grayed 

out. 

 

Selecting Multiple Calculations 

 
To select multiple calculation one at a time in the Calculation tab press the CTRL key 

and select the calculation to be displayed.    The calculation selected will be highlighted 

and appear in the model.  

 

To select multiple calculations in the Calculation tab press the Shift key and then select 

the group of calculations that are to be displayed.  The calculations selected will be 

highlighted and appear in the model.  

 

 

New Distance Calculation (Ctrl-K)... 

 
Use this command to open the Edit Distance Calculation dialog box. Preview will 

calculate the distance between the two marks you select in this dialog box and display the 

results in the Calculations list and in the model. 

New Centerline Calculation (Ctrl-L)... 

 
This command opens the Edit Centerline Calculation dialog box. You can measure the 

length along the centerline of a blood flow channel (in Preview vascular applications) by 

specifying the upper and lower aorta or aorta-iliac slices of the segment you want to 

measure. 

New Volume Calculation... 

 
This command opens the Edit Volume Calculation dialog box. In this box, select the 

object you want to measure, and type the slice numbers of the upper and lower axial 

slices of the object to be measured. 

New Multiline Calculation... 

 
This command opens the Edit Multiline Calculation dialog box where you select and sort 

the marks that form the path to be measured. 
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New Angle Calculation (Ctrl-A)... 

 
This command opens the Edit Angle Calculation dialog box where you select three marks 

that create the angle to be measured. 

New Stenosis Calculation (Ctrl-C)... 

 
This command opens the Edit Stenosis Calculation dialog box. Preview will calculate the 

percentage of stenosis between the two marks you select in this dialog box and display 

the results in the Calculations list. 
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Model Menu 

 
Open the Model menu to change the background color and lighting in the Model window. 
The Model menu also has a Spin Model feature, which causes the 3D model to automatically 
rotate for better viewing. 

Background Color 

 
Select this to display a list of background colors to choose from. Click the custom... 

option to choose a background color not included in the list. A “Select the Model 

Background Color” dialog box will appear. Click on the desired color, and then click OK 

to set it as the model background color. 

Lighting 

 
Select this to display lighting options. Clicking Upper Right will light the model from 

the upper right, while clicking Front will light it from the front. The default lighting is 

Front.  

 

Note: If images of the model are to be used in presentation 

software, such as PowerPoint, then Front lighting may be a 

better choice than Upper Right lighting. 

Spin Model 

 
Select the Spin Model checkbox to spin the model in its current orientation. To stop the 

model from spinning, deselect the Spin Model checkbox by clicking it. 

Show Mark Diameters 

 
This will toggle whether or not Preview shows mark diameters in the model window. 

Show Mark Names 

 
This will toggle whether or not Preview shows mark names in the model window. 
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Help Menu 

 
The Help Menu provides easy-to-access information about how to use M2S Preview. Help’s 
Quick Start Topics provide steps for using many of Preview’s features. 

About Preview 

 
Select About Preview to view the version number of your Preview software. 

Help Topics 

 
Select Help Topics to view the help interface.  

Menu Commands 

 
Select Menu Commands to display links to help pages on Preview’s menus and Tool 

Palette. Click a link to a menu to view the menu’s commands, the commands' shortcut 

keys, and descriptions of the commands' actions. Click the Tool Palette link for 

instructions on how to use the tools in the Tool Palette. 

Edit Preferences... 

 
Select Edit Preferences to open a window where you can set preferences for all 

subsequent Preview sessions.  

 

Under the Views tab, select options for how the model looks after the virtual graft has 

been drawn, and whether to view centerlines by default.  

 

Under the Model tab, setting preferences for background color, lighting, visibility of left 

and right indicators, and direction and speed of model spin. Select whether to build the 

generic graft legs from trunk or start slice in the VirtualGraft tab.  

 

Under the Other tab, toggle whether or not the My Notes dialog is always on top, toggle 

whether or not Preview displays a mark selection box in the slice window and the default 

way that Preview creates reports.  

 

Also under the Other tab are options regarding Preview and Preview Archive Files as 

well as general options about the automatic creation of sagittal and coronal slices.  

 

The first option is to automatically generate sagittal and coronal slices. Turn this on if 

you have a fast computer with a relatively large amount of available RAM, as this 
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process can be quite memory intensive. With this option enabled, Preview will attempt to 

automatically create .12-bit versions of the sagittal and coronal slices for studies that may 

not have included them originally due to file size considerations. 

 

The next two options concern the size of the cache for these .12-bit files. When creating 

these files for a downloadable Preview Archive (.par), Preview will put them in a 

temporary location and cache them. Change the slider to change the maximum size of 

this cache and click ‘Delete Cache on Exit’ to delete the cache. 

 

Click OK or Apply to set preferences. Click Cancel to exit without setting the 

preferences. Preview may need to be restarted for all the preferences to be set. 

 

Preview Help 

 
Select Preview Help to open a brief walkthrough of some of the features that are new to 

Preview. 

VirtualGraft Help 

 
Select Virtual Graft Help to see a tutorial on the new Virtual Graft interface. 
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The Lists Area Tabs 

 
A row of tabs under the Main Preview Window menu bar controls the display of lists where 
Preview collects patient and plan information. Use these tabs to access information about 
the model and the patient’s scan, and to view your current plan and its associated marks, 
calculations, bookmarked slices, drop slices, and model views. The lists also provide several 
command buttons that allow you to perform calculations, bookmark slices, delete marks, add 
model views, etc. — many of the same functions available in the Preview’s menus. 

Patient Tab 

 
Click the Patient tab to display links to information about the patient-specific software. 

Click the links to open windows that contain such information as details about the patient 

scan, the model pictures, and notes made by M2S during modeling. 

  

Preview will also display links to PEMS in this window. Preview will always display a 

link titled Go To PEMS which will open up your browser to the current patient’s page in 

PEMS. To access this feature, you’ll need to login using your PEMS username and 

password. Additionally you’ll have to have Internet access and the authorization to view 

the current patient in PEMS. 

 

Preview will also check the PEMS system for M2S plan files during startup. If there is a 

plan available, Preview will display a Download Plan From PEMS link. Click this and 

enter your name and password and Preview will download and open the plan from 

PEMS. Preview will also save the plan in your Preview Plans directory.  

Plan Tab 

 
Click the Plan tab to view a summary of your Plan Document File. Click the Marks, 

Calculations, Bookmarked Slices, Drops Slices, or Views links to open their associated 

lists. 

 

Click the My Notes link to open a text window where you can type notes regarding the 

current plan document. These notes become part of the patient report. See the section 

entitled Creating a Report. 

Marks Tab 

 
Click the Marks tab to show the Marks list, which lists all marks in the current plan. 

 

To jump to a specific mark, highlight the mark name in the Marks list, then click the 

Jump button. All open slice windows display the slice with the highlighted mark. 
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To Auto size a bloodflow mark to be equal to the bloodflow diameter, select the 

Bloodflow checkbox and click the Auto Size button.  To Auto size a lumen mark to be 

equal to the lumen diameter, ensure the Bloodflow checkbox is not selected and click the 

Auto Size button.  To delete a mark, highlight it in the Marks list and click the Delete 

button. To change how marks are displayed, click Display to open a drop-down list of 

options. To hide the yellow cross indicator created by the Jump Slice tool, uncheck the 

Crosshair Visible checkbox. 

Calculations Tab 

 
Click the Calculations tab to show the Calculations list which displays the current plan’s 

calculations. 

 

To delete a calculation, highlight it in the list and click the Delete button. To create a new 

calculation, click New Calculation and select the appropriate calculation from the drop-

down list. To change how calculations are displayed, click Display and select the desired 

options from the drop-down list. 

VirtualGraft Tab 

 
Click the VirtualGraft tab to build and order a Manufacturer-Specific or Generic graft. 

Click OK when the program alerts you that it will change to oblique slices. 

 

Determine the starting point of the graft by either scrolling through the slice images in the 

Slice area or dropping a slice in the model by clicking the View Start Slice checkbox. 

Click Grab Slice to enter the start slice number in the text field. 

 

Click Build Graft to select a manufacturer and graft components. The VirtualGraft 

scenario will be added to the devices window. Change the graft’s appearance by selecting 

or deselecting the Visible and Transparent checkboxes. Multiple grafts can be created. 

Highlight appropriate graft in the devices window, and select the Edit or Delete buttons 

to edit or delete the graft. 

 

Select the Order Form button to review graft components, add parts and auto-populate 

an order form. 

Diameter Evaluator Tab 

 
Click the Diameter Evaluator tab to evaluate the diameter throughout the aorta and the 

iliacs, and estimate the fit of a delivery system through them. Preview places tubes in the 

3D model. Use the iliac diameter sliders to change the tube diameters in millimeters. 

Preview calculates the diameter in French based on the conversion 3 Fr = 1 mm. 
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Use the visibility slider to set the transparency of the tubes or to turn them off in the 3D 

model. Use the color drop-down menu to set the tubes to the desired color, including 

choosing a custom color. 

Bookmarks Tab 

 
Click the Bookmarks tab to show the Bookmarks list, which displays the slice numbers 

of all slices in the current plan that you have bookmarked. 

 

To bookmark the current slice, click Add Bookmark. Highlight a bookmark name and 

click Comment to add a comment. The comment appears to the right of the slice number 

in the Bookmarks list. To delete a bookmark, highlight the slice number in the list and 

click the Delete button. 

Drop Slices Tab 

 
Click the Drop Slices tab to show the Drop Slices list, which displays the current plan’s 

drop slices. 

 

To hide a drop slice, uncheck the Visible checkbox. To delete a drop slice from the plan, 

highlight it in the list and click the Delete button. 

Views Tab 

 
Click the Views tab to show a list of the six standard views of the 3D model and any 

custom views you have added (see Add View below). The six viewpoints provided by 

Preview are Anterior, Posterior, Sagittal-Patient Right, Sagittal-Patient Left, Axial-

Superior, and Axial-Inferior. 

 

Double-click on a view name, and the model adjusts to that view’s angle and zoom 

settings. 

 

Add View — To save a custom view of the model, first rotate, pan, and zoom the 3D 

image to the desired point of view, then click Add View. Preview adds the view to the 

Views list as View 1. 

 

To delete a custom view, highlight the view in the list, then click Delete. The six standard 

views cannot be deleted. 
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Slice Area Settings 

 
Below the Slice image are up to six tabs that allow you to control the view of the CT scan 
slices, adjust Window/Level settings, and perform centerline, tube graft, C-Arm and volume 
calculations. Click any of the tabs to display their various settings and controls. 
 

 
The tabs and tools below the Slice area. 

Slice Controls 

 
Click the Slice Controls tab to display several slice settings. The red-lettered button at 

the far left indicates the name of the current slice. Click the button to display a popup 

menu of slice options, then click an option to change the image in the Slice area. 

 

Slice Number Button — The button to the right of the red-lettered button displays the 

current slice number. Click this button to open the Go To Slice # dialog box, which you 

can use to move to a particular slice. 

 

Zoom Controls — The Zoom In and Zoom Out buttons offer an easy way to increase 

and decrease the size of the slice image. Click the Zoom In button to double the slice 

image; click the Zoom Out button to reduce the slice image by half. Click the button 

showing the current size percentage (to the right of the Zoom buttons) to open a popup 

menu with image-size options. 

 

Cur Slice — Select this checkbox to drop the current slice into the 3D Model. To remove 

the slice, uncheck the checkbox. 

 

Bookmark —  Select this checkbox to add the current slice to the Bookmarks list. 

 

Open — Click the Open button to open a new Slice window that displays the same slice 

on the right side of the screen. 

 

Window/Level 

 
Clicking the Window/Level tab displays controls to adjust the quality of slice images and 

their contrast and brightness. 
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To learn more about the Window/Level tab, refer to the section entitled Working with 

Slices. 

Centerline 

 
Clicking the Centerline tab displays the settings for calculating the centerline of 

bloodflow in a vascular application. (If your patient-specific software is not a vascular 

application, the Centerline tab is absent.) In the model, the heavy dotted lines depict the 

centerline of each flow channel. If they are not visible, open the Anatomy tab and change 

the obstructing objects to a transparent or invisible format. For more information on 

performing Centerline calculations, see the section entitled Calculating Centerlines or 

Path Length.  

 

Selecting a flow channel — Click the button to the left of the calculation result (in red) 

to select Aorta, Aorta-Left Iliac, or Aorta-Right Iliac. 

 

When you first open the Centerline tab, the Slice 1 and Slice 2 buttons show the 

beginning and ending slice numbers of the entire length of the selected blood-flow 

channel. The length of the selected channel appears in red. 

 

Displaying the Centerline calculation result — Click the Record button to open the 

Edit Centerline Calculation dialog box. Here, you can specify the length of the blood 

flow channel you want to appear in the model, its color, and whether it will be displayed 

as a line or a tube. After you click OK, Preview displays the centerline tube or line in the 

model. It also calculates the centerline’s length and displays it in the Calculations list. 

C-Arm 

 
Clicking the C-Arm tab displays the tool for creating a C-Arm angle calculation.  

 

This tool automates the creation of an angle calculation based on a particular aortic slice. 

This saves time and effort involved in trying to describe an angle in 3-dimensional space. 

The tool begins by simply taking the number of the aortic slice at the press of the Create 

Angle Calc button. The tool then gets the orientation of this slice and calculates the angle 

of this slice in the sagittal plane relative to the axial plane. The tool places three marks, 

one in the center of the slice, one directly anterior to this mark, and one at the anterior 

crossing of this oblique plane with the sagittal plane through the first mark. The angle is 

then calculated between these three marks, putting the one in the center of the oblique 

slice in the middle of the angle. This angle represents the angle of the oblique slice in the 

cranio-caudal plane and is used for a pre-operative assessment of the proper C-Arm 

angle. 

 

After clicking the Create Angle Calc button, the Show View button will become 

enabled. This indicates that Preview has also created a ‘C-Arm View’ and put it in your 
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list of views. To go to this view immediately click Show View. The tool works by taking 

the same angle calculated above, but rather than creating an angle, it centers the Preview 

model window on the selected centerline cube and rotates the view until it is looking at 

the anatomy at this angle. In this way it simulates the view from the C-Arm.  

 

Note: After clicking Show View, the model will now rotate around the center of this 

angle calc instead of the center of the model. To change back to the normal mode of 

rotation, click on the Restore View button which used to say ‘Show View’. 

Volume 

 
Clicking the Volume tab displays the settings for measuring the volume of specified 

objects in the scan. (Note that the Volume tab is not available in all studies.) For more 

information on calculating volumes, see the section entitled Calculating the Volume of 

an Object. 

 

When you first open the Volume tab, the Slice 1 and Slice 2 buttons show the beginning 

and ending slice numbers of the entire length of the selected object, and the volume of the 

object appears in red. 

 

Selecting an object — Click the Object popup list to select the object you want to 

measure. 

 

Displaying a volume calculation — Click the Record button to open the Edit Volume 

Calculation dialog box. Here, you can specify the length of the object you want to 

measure and the color of the wireframe box that will surround that portion of the model.  

 

After you click OK, Preview calculates the volume amount and displays it in the 

Calculations list. A wire-frame box appears in the model around the measured object. 
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The Preview Tool Palette 

 
The Tool Palette consists of the five tool buttons in the menu bar at the top of the Main 
Preview Window or slice windows. The Tool Palette provides you with quick access to four 
important Preview functions: marking/rotating, zooming, panning images, jumping slices, 
and free rotation. To activate a tool, click on the tool button in the Tool Palette. The 
following tables describe the tools and alternative shortcuts. 
 

Button Description 

 

 

 

 

Mark/Rotate tool: In a slice image, it functions as a Mark tool, 

which you use to insert, select, and move marks. In the 

Model, it functions as a Rotate tool, which you use to rotate 

the model. 

 

Shortcut: The Mark/Rotate tool is the default tool in Preview. 

To rotate the model, just click anywhere in the model window 

and drag the mouse. To zoom into the model, just right-click 

and drag the mouse forward or backward.  

 

Shortcut in the Slice area: Just click anywhere in a slice to 

drop a mark in that part of the slice.  

 

 

 

 

 

 

 

Zoom tool: Use to enlarge or reduce an image. 

To enlarge a slice image, click the Zoom tool, then click 

anywhere in the slice image. To reduce the image size, click 

the Zoom tool, and while holding down the Shift key, click in 

the slice image. 

To change the size of the model, click the Zoom tool, put the 

cursor in the Model area, then hold the mouse button down 

and drag forwards to zoom in (enlarge) and backwards to 

zoom out (reduce). 

 

Shortcut in the Slice area: Right-click in the Slice area to 

zoom in; right-click while holding down the Shift key to 

zoom out.  

 

Shortcut in the Model area: Right-click in the Model area and 

drag mouse forward to zoom in; right-click and drag 

backwards to zoom out. 

 

 

 Pan tool: Use to drag (pan) the Model or zoomed slice 

images from side to side and up and down. 

 

Shortcut: Holding down the Shift key changes the cursor into 

the Pan tool. Hold down the Shift key and left mouse button, 

and drag the image with the mouse. 
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Note:  When using the Jump Slice tool in the model, only the 

anatomical objects are detected. The tool will ignore drop 

slices, marks and calculations that may be "in front" of the 

object. Also, if you click the dark-blue background, the jump 

slice will not update. 

 

 

 

Jump Slice tool: Click this tool, then click a location in a slice 

or the model. All Slice windows jump to that location, and a 

cross indicator appears in the corresponding location in the 

model. Can be used in both the Model and Slice areas. 

 

Shortcut: Holding down the Control key changes the cursor 

into the Jump Slice tool. Hold down the Control key and click 

the desired location. The cross marker appears at the same 

location in each Slice window and in the Model. 

 

 
 

 Free Rotation tool: Click this tool, then click a location in the 

model.   Left click and drag in the left-right direction to rotate 

the model about a vertical axis.  Left click and drag in the up-

down direction to rotate a model about the horizontal axis. 

 

Shortcut: Hold down the left and right arrow keys to rotate 

the Model about the vertical axis.  Hold down the up and 

down arrow keys to rotate the Model about the horizontal 

axis.  Hold down the Alt Key and the left and right arrow keys 

to rotate the Model clockwise and counterclockwise. 

 

 

Polygon Tool: Click this tool to turn on or off the polygon 

tool.  When the tool is selected a polygon can be constructed 

by using the left click on the mouse. The polygon is 

completed once the start vertex has been reached.  The area 

and the perimeter results are displayed both in the slice 

window and the calculations tab. 

 

 

Projection tool: Click this tool to toggle between a 

perspective (default) and orthographic projection of the 

model.  If the “C-Arm Views” tab has been selected then 

Orthographic view will be the default. 
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Preview Measurement Type Definitions 

 

Type Definition Detail 

Volume from Renal to AO 

Bifur 

Volume of contents of aorta 

and iliac vessels, measured 

on axial slices from distal 

renal artery to aortic 

bifurcation 

 

Volume from Renal to 

Right Hypogastric 

Volume of contents of aorta 

and iliac vessels, measured 

on axial slices from distal 

renal artery to take-off of 

right internal iliac artery 

 

Endoleak Volume from 

Renal to AO Bifur 

Volume of endoleak, 

measured on axial slices 

from the distal renal artery to 

the aortic bifurcation 

 

Endoleak Volume from 

Renal to Right 

Hypogastric 

Volume of endoleak, 

measured on axial slices 

from the distal renal artery to 

the aortic bifurcation 

 

Maximum AAA Diameter Maximum diameter of 

aneurysm sac on slice 

perpendicular to bloodflow 

centerline 

 

Gate Mark Mark on a modular graft that 

defines the attachment zone 

of the contralateral limb 

 

Aortic Bifurcation 

Diameter 

Diameter of the aorta at the 

point of bifurcation 

 

Minimum Suprarenal 

Aortic Diameter 

Minimum diameter of 

suprarenal aorta on 

orthogonal slice 

 

Minimum Distal Aortic 

Diameter 

Minimum diameter of distal 

aorta on orthogonal slice at 

aortic bifurcation 

 

Aortic Diameter at Renals Diameter of aorta 1mm 

below distal renal artery 

measured on slice 

perpendicular to bloodflow 

centerline 

Diameter represents 

adventita-adventia 

diameter. 

Aortic Diameter 15mm 

Below Renals 

Diameter of aorta on 

orthogonal slice 15mm 
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below distal renal artery 

Aortic Diameter at Distal 

End of Proximal Neck 

Diameter of aorta on 

orthogonal slice at most 

distal extent of proximal 

neck 

 

Aortic Diameter at Top of 

Stent-Graft 

Diameter of aorta at 

proximal end of stent-graft 

measured on slice 

perpendicular to bloodflow 

centerline 

1st slice where proximal 

end of stent appears as a 

full circle. Diameter 

represents adventita-

adventia diameter. 

Aortic Diameter 10mm 

Below Top of Stent-Graft 

Diameter of aorta 10mm 

below top of stent-graft 

measured on slice 

perpendicular to bloodflow 

centerline 

Diameter represents 

adventita-adventia 

diameter. 

Aortic Diameter at Most 

Distal Stent-Graft 

Apposition* 

Diameter of aorta at most 

distal extent of stent-graft 

apposition measured on slice 

perpendicular to bloodflow 

centerline 

Location is one slice 

proximal to end of aortic 

stent-graft apposition 

above stent-graft 

bifurcation point. Diameter 

represents adventita-

adventia diameter. 

Aortic Diameter at Most 

Proximal Stent-Graft 

Apposition 

Diameter of aorta on 

orthogonal slice at most 

proximal extent of stent-graft 

apposition 

 

Right Common Iliac 

Aneurysm 

10% increase in vessel 

diameter within the right 

common iliac artery 

 

Left Common Iliac 

Aneurysm 

10% increase in vessel 

diameter within the left 

common iliac artery 

 

Minimum Access 

Diameter of Right External 

Iliac 

Minimum lumen diameter on 

orthogonal slices within right 

external iliac artery 

 

Minimum Access 

Diameter of Right 

Common Iliac 

Minimum lumen diameter on 

orthogonal slices within right 

common iliac artery 

 

Minimum Access 

Diameter of Left External 

Iliac 

Minimum lumen diameter on 

orthogonal slices within left 

external iliac artery 

 

Minimum Access 

Diameter of Left Common 

Iliac 

Minimum lumen diameter on 

orthogonal slices within left 

common iliac artery 

 

Representative Diameter Representative lumen  
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of Right External Iliac diameter on orthogonal 

slices within right external 

iliac artery 

Representative Diameter at 

Right Common Iliac 

Representative lumen 

diameter on orthogonal 

slices within right common 

iliac artery 

 

Representative Diameter 

of Left External Iliac 

Representative lumen 

diameter on orthogonal 

slices within left external 

iliac artery 

 

Representative Diameter at 

Left Common Iliac 

Representative lumen 

diameter on orthogonal 

slices within left common 

iliac artery 

 

Diameter at Right Iliac 

Proximal Stent-Graft 

Apposition 

Diameter of right iliac artery 

at proximal extent of stent-

graft apposition measured on 

slice perpendicular to 

bloodflow centerline 

Diameter represents 

adventita-adventia 

diameter. 

Diameter at Right Iliac 

Distal Stent-Graft 

Apposition* 

Diameter of right iliac artery 

at distal extent of stent-graft 

apposition measured on slice 

perpendicular to bloodflow 

centerline 

Diameter represents 

adventita-adventia 

diameter. 

Diameter at Left Iliac 

Proximal Stent-Graft 

Apposition 

Diameter of left iliac artery 

at proximal extent of stent-

graft apposition measured on 

slice perpendicular to 

bloodflow centerline 

Diameter represents 

adventita-adventia 

diameter. 

Diameter at Left Iliac 

Distal Stent-Graft 

Apposition* 

Diameter of left iliac artery 

at distal extent of stent-graft 

apposition measured on slice 

perpendicular to bloodflow 

centerline 

Diameter represents 

adventita-adventia 

diameter. 

Proximal Aortic Neck 

Length 

Centerline length of the 

proximal aortic neck 

 

Left Iliac Sealzone* Vessel centerline distance 

from proximal to distal 

points of complete graft 

apposition within left iliac 

Vessel centerline length 

between the most proximal 

to most distal slice 

locations showing 

complete stent-graft 

apposition within the left 

iliac artery. Calculated 

using slices reformatted 

perpendicular to vessel 
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centerline. 

Renal to Aortic 

Bifurcation 

Centerline length from renal 

artery to common iliac 

(aortic) bifurcation 

 

Renal to Left Hypogastric Centerline distance from 

distal renal artery to left 

internal iliac 

 

Renal to Right 

Hypogastric 

Centerline distance from 

distal renal artery to right 

internal iliac 

 

Right Iliac Sealzone* Vessel centerline distance 

from proximal to distal 

points of complete graft 

apposition within right iliac. 

Vessel centerline length 

between the most proximal 

slice to most distal slice 

locations showing 

complete stent-graft 

apposition within the right 

iliac artery. Calculated 

using slices reformatted 

perpendicular to vessel 

centerline. 

Proximal Neck Graft 

Apposition* 

Vessel centerline distance 

from proximal to distal 

points of complete graft 

apposition within proximal 

aortic neck 

Vessel centerline length 

between the most proximal 

slice location showing a 

complete, circular stent in 

aortic apposition to the 

most distal slice location 

showing complete circular 

aortic stent-graft 

apposition. Calculated 

using slices reformatted 

perpendicular to vessel 

centerline. 

Right Iliac Graft 

Apposition* 

Vessel centerline distance 

from proximal to distal 

points of complete graft 

apposition within right iliac 

Vessel centerline length 

between the most proximal 

slice to most distal slice 

locations showing 

complete stent-graft 

apposition within the right 

iliac artery. Calculated 

using slices reformatted 

perpendicular to vessel 

centerline. 

Left Iliac Graft 

Apposition* 

Vessel centerline distance 

from proximal to distal 

points of complete graft 

apposition within left iliac 

Vessel centerline length 

between the most proximal 

to most distal slice 

locations showing 
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complete stent-graft 

apposition within the left 

iliac artery. Calculated 

using slices reformatted 

perpendicular to vessel 

centerline. 

Distance From Distal 

Renal to Top of Graft 

Vessel centerline distance 

from distal renal artery to 

proximal end of aortic stent 

graft 

Vessel centerline distance 

from most distal renal 

artery to most proximal 

slice location showing 

50% circumference of 

aortic stent. Calculated 

using slices reformatted 

perpendicular to vessel 

centerline. 

Angle Proximal Neck to 

AAA Body 

Angle of proximal neck of 

the aorta relative to main 

body of the aneurysm (3D, 

angle of deviation) 

Calculated as the 3D angle 

between three points: a) 

center of aorta at proximal 

end of stent-graft; to b) 

center of aorta at location 

of distal graft apposition; 

to c) center of the aortic 

bifurcation. 

Angle Suprarenal Aorta to 

Proximal Neck 

Angle of suprarenal aorta 

relative to aortic proximal 

neck (3D, angle of deviation) 

Calculated as the 3D angle 

between three points: a) 

center of the aorta just 

below celiac origin to b) 

center of aorta at distal 

renal to c) center of aorta 

at location of distal graft 

apposition. 

C-Arm Gantry Correction 

Angle 

Angle in the cranio-caudal 

plane between a line 

perpendicular to the aorta at 

the proximal landing target 

and anterior-posterior view 

 

NASCET North American 

Symptomatic Carotid 

Endarterectomy Trial 

Measurement 

Stenosis measurement 

ECT European Carotid Trial 

Measurement 

Stenosis measurement 

 

*M2S' assessment of stent-graft apposition is based upon stent alone. Please note that 

there is significant variation in the configuration of stent-grafts: some with stents 

completely covered by fabric and others with bare-metal stents at proximal and distal 
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ends. Contact the manufacturer if you are not sure about the configuration of the graft 

used for this patient. 
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Keyboard Shortcuts 

 

Menu 

Command 

Key Combination Command Description 

Auto Size Ctrl-M Auto size the current mark to be the diameter 

of the bloodflow or lumen.  This feature is 

only available for oblique marks created in 

Preview.  It is not available for marks 

downloaded from a PEMS plan. 

Current Slice 

in Model 

Ctrl-E Insert the current slice into its corresponding 

position in the 3D model. 

Delete Delete key or backspace 

key 

Remove the selected mark, calculation, 

dropped slice, current slice, bookmarked 

slice, or custom view. 

Drop Slice 

Into Model 

Ctrl-D Insert the current slice into its corresponding 

position in the 3D model. 

Exit Ctrl-X Exit the Preview program. 

Free Rotation Arrow key 

Alt + right/left arrow keys 

Rotate the model about a vertical or 

horizontal axis.  Rotate the model 

counterclockwise or clockwise. 

 

Go to Slice 

#... 

Ctrl-G Display the Go to Slice # dialog box, which 

you can use to go to a specific slice number 

in the active window. 

Jump Slices 

to Mark 

Ctrl-J Update (“jump”) all slice images to the 

location of the selected mark or the last mark 

placed on a slice. This feature is available 

only when a Mark is selected. 

Jump Slice 

Tool 

Control key While holding down the Control key, click a 

slice image to jump all slice images to the 

same location. Can be used in both the Model 

and in Slices. 

New Ctrl-N Open a new plan file in which you can save 

marks, views, and calculations for the 

patient-specific data that is currently loaded. 

New Angle 

Calculation 

Ctrl-A Open the Edit Angle dialog box to measure 

the angle created by three selected marks. 

New 

Centerline 

Calculation 

Ctrl-L Open the Edit Centerline Calculation dialog 

box to measure the centerline of a bloodflow 

channel. 

New 

Distance 

Calculation 

Ctrl-K Open the Edit Distance Calculation dialog 

box to measure the distance between two 

marks. 
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New Stenosis 

Calculation 

Ctrl-C Open the Edit Stenosis Calculation dialog 

box to measure the percentage stenosis 

between two marks. 

Next Slice Ctrl-]  

Or 

Right Arrow 

Display the slice that follows the current 

slice. 

Open Ctrl-O Display a selection box from which you can 

open a previously saved plan file. 

Pan Tool Shift key While holding down the Shift key and left 

mouse button, move the mouse to drag (pan) 

the model or zoomed slices from side to side 

and up and down. 

Previous 

Slice 

Left Arrow Display the slice that precedes the current 

slice. 

Print Ctrl-P Print a hard copy of the active window. 

Save Ctrl-S Save changes to the current plan file. 

Set Drop 

Slice Trans...  

Ctrl-T Open the Drop Slice Transparency Level # 

dialog box to adjust the level of transparency 

in dropped slices. 

Zoom In 

(model) 

Right-Click and drag 

mouse up on model 

Enlarge the model image. 

Zoom Out 

(model) 

Right-Click and drag 

mouse down on model 

Reduce the size of the model image. 

Zoom In 

(slice) 

Right-Click on image Enlarge the slice image. 

Zoom Out 

(slice) 

Shift and Right- Click on 

image  

Reduce the size of the slice image. 

Window 

Level 

Alt and hold left mouse 

button while dragging 

mouse horizontally on 

slice window 

Adjusts window (brightness) of slices  

Window Level Alt and hold left mouse 

button while dragging 

mouse vertically on 

slice window 

Adjusts level (contrast) of slices 

 

 


